Forensic Toolkit (FTK)

Installation Guide

6.x
AccessData Legal and Contact Information

Document date: February 1, 2018

Legal Information

©2018 AccessData Group, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher.

AccessData Group, Inc. makes no representations or warranties with respect to the contents or use of this documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, AccessData Group, Inc. reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any person or entity of such revisions or changes.

Further, AccessData Group, Inc. makes no representations or warranties with respect to any software, and specifically disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, AccessData Group, Inc. reserves the right to make changes to any and all parts of AccessData software, at any time, without any obligation to notify any person or entity of such changes.

You may not export or re-export this product in violation of any applicable laws or regulations including, without limitation, U.S. export regulations or the laws of the country in which you reside.

AccessData Group, Inc.
588 West 400 South Suite 350
Lindon, UT 84042
USA

AccessData Trademarks and Copyright Information

The following are either registered trademarks or trademarks of AccessData Group, Inc. All other trademarks are the property of their respective owners.

AccessData®
AccessData Certified Examiner® (ACE®)
AD AccessData™
AD eDiscovery®
AD RTK™
AD Summation®
Discovery Cracker®
Distributed Network Attack®
DNA®
Forensic Toolkit® (FTK®)
LawDrop®
Mobile Phone Examiner Plus®
MPE+ Velocitor™
Password Recovery Toolkit®
PRTK®
Registry Viewer®
Summation®
A trademark symbol (®, ™, etc.) denotes an AccessData Group, Inc. trademark. With few exceptions, and unless otherwise notated, all third-party product names are spelled and capitalized the same way the owner spells and capitalizes its product name. Third-party trademarks and copyrights are the property of the trademark and copyright holders. AccessData claims no responsibility for the function or performance of third-party products.

Third party acknowledgements:

- AFF® and AFFLIB® Copyright® 2005, 2006, 2007, 2008 Simson L. Garfinkel and Basis Technology Corp. All rights reserved.
- Copyright © 2005 - 2009 Ayende Rahien

BSD License:
Copyright (c) 2009-2011, Andriy Syrov. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer; Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution; Neither the name of Andriy Syrov nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

WordNet License:
This license is available as the file LICENSE in any downloaded version of WordNet.
WordNet 3.0 license: (Download)
WordNet Release 3.0 This software and database is being provided to you, the LICENSEE, by Princeton University under the following license. By obtaining, using and/or copying this software and database, you agree that you have read, understood, and will comply with these terms and conditions.: Permission to use, copy, modify and distribute this software and database and its documentation for any purpose and without fee or royalty is hereby granted, provided that you agree to comply with the following copyright notice and statements, including the disclaimer, and that the same appear on ALL copies of the software, database and documentation, including modifications that you make for internal use or for distribution. WordNet 3.0 Copyright 2006 by Princeton University. All rights reserved. THIS SOFTWARE AND DATABASE IS PROVIDED "AS IS" AND PRINCETON UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY WAY OF EXAMPLE, BUT NOT LIMITATION, PRINCETON UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES OF MERCHANT- ABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE LICENSED SOFTWARE, DATABASE OR DOCUMENTATION WILL NOT INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER RIGHTS. The name of Princeton University or Princeton may not be used in advertising or publicity pertaining to distribution of the software and/or database.
Title to copyright in this software, database and any associated documentation shall at all times remain with Princeton University and LICENSEE agrees to preserve same.

XMLmind XSL-FO Converter Professional Edition Developer License Agreement:

Distribution
Licensee may not distribute with the Application any component of the Software other than the binary class library (xfc.jar) for the JavaTM version and the Dynamic Link Library file (xfc.dll) for the .NET version.

Licensee shall include the following copyright notice: “XMLmind XSL-FO Converter Copyright © 2002-2009 Pixware SARL”, with every copy of the Application. This copyright notice may be placed together with Licensee’s own copyright notices, or in any reasonably visible location in the packaging or documentation of the Application. Licensee may use, distribute, license and sell the Application without additional fees due to Licensor, subject to all the conditions of this License Agreement.

Documentation Conventions

In AccessData documentation, a number of text variations are used to indicate meanings or actions. For example, a greater-than symbol (>) is used to separate actions within a step. Where an entry must be typed in using the keyboard, the variable data is set apart using [variable_data] format. Steps that require the user to click on a button or icon are indicated by Bolded text. This Italic font indicates a label or non-interactive item in the user interface.

A trademark symbol (®, ™, etc.) denotes an AccessData Group, Inc. trademark. Unless otherwise notated, all third-party product names are spelled and capitalized the same way the owner spells and capitalizes its product name. Third-party trademarks and copyrights are the property of the trademark and copyright holders. AccessData claims no responsibility for the function or performance of third-party products.

Registration

The AccessData product registration is done at AccessData after a purchase is made, and before the product is shipped. The licenses are bound to either a USB security device, or a Virtual CmStick, according to your purchase.

Subscriptions

AccessData provides a one-year licensing subscription with all new product purchases. The subscription allows you to access technical support, and to download and install the latest releases for your licensed products during the active license period.

Following the initial licensing period, a subscription renewal is required annually for continued support and for updating your products. You can renew your subscriptions through your AccessData Sales Representative.

Use License Manager to view your current registration information, to check for product updates and to download the latest product versions, where they are available for download. You can also visit our web site, www.accessdata.com anytime to find the latest releases of our products.

For more information, see Managing Licenses in your product manual or on the AccessData website.
AccessData Contact Information

Your AccessData Sales Representative is your main contact with AccessData. Also, listed below are the general AccessData telephone number and mailing address, and telephone numbers for contacting individual departments.

Mailing Address and General Phone Numbers

You can contact AccessData in the following ways:

**AccessData Mailing Address, Hours, and Department Phone Numbers**

<table>
<thead>
<tr>
<th>Corporate Headquarters</th>
<th>AccessData Group, Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>588 West 400 South Suite 350</td>
</tr>
<tr>
<td></td>
<td>Lindon, UT 84042 USA</td>
</tr>
<tr>
<td><strong>Voice:</strong> 801.377.5410; <strong>Fax:</strong> 801.377.5426</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General Corporate Hours</th>
<th>Monday through Friday, 8:00 AM – 5:00 PM (MST)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AccessData is closed on US Federal Holidays</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>State and Local Law Enforcement Sales</th>
<th>Voice: 800.574.5199, option 1; Fax: 801.765.4370</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email:</strong> <a href="mailto:Sales@AccessData.com">Sales@AccessData.com</a></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Federal Sales</th>
<th>Voice: 800.574.5199, option 2; Fax: 801.765.4370</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email:</strong> <a href="mailto:Sales@AccessData.com">Sales@AccessData.com</a></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Corporate Sales</th>
<th>Voice: 801.377.5410, option 3; Fax: 801.765.4370</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email:</strong> <a href="mailto:Sales@AccessData.com">Sales@AccessData.com</a></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Training</th>
<th>Voice: 801.377.5410, option 6; Fax: 801.765.4370</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email:</strong> <a href="mailto:Training@AccessData.com">Training@AccessData.com</a></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Accounting</th>
<th>Voice: 801.377.5410, option 4</th>
</tr>
</thead>
</table>

Technical Support

Technical support is available on all currently licensed AccessData solutions. You can contact AccessData Customer and Technical Support in the following ways:

**AccessData Support Portal**

You can access the Chat, Knowledge Base, Discussion Boards, White Papers and more through the AccessData Support Portal:

https://support.accessdata.com

**E-Mail Support:**

support@accessdata.com

**Telephone:**

Americas/Asia-Pacific:

800-658-5199 (North America)
Support Hours: Mon-Fri, 7:00 AM – 6:00 PM (MST), except corporate holidays.

NOTE: Emergency support is available on weekends:
Saturday and Sunday 8:00am – 6:00pm MST via support@accessdata.com

Documentation

Please email AccessData regarding any typos, inaccuracies, or other problems you find with the documentation: documentation@accessdata.com

Professional Services

The AccessData Professional Services staff comes with a varied and extensive background in digital investigations including law enforcement, counter-intelligence, and corporate security. Their collective experience in working with both government and commercial entities, as well as in providing expert testimony, enables them to provide a full range of computer forensic and eDiscovery services.

At this time, Professional Services provides support for sales, installation, training, and utilization of Summation, FTK, FTK Pro, Enterprise, eDiscovery, Lab and the entire Resolution One platform. They can help you resolve any questions or problems you may have regarding these solutions.

Contact Information for Professional Services

Contact AccessData Professional Services in the following ways:

AccessData Professional Services Contact Information

<table>
<thead>
<tr>
<th>Contact Method</th>
<th>Number or Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>North America Toll Free: 800-489-5199, option 7</td>
</tr>
<tr>
<td></td>
<td>International: +1.801.377.5410, option 7</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:services@accessdata.com">services@accessdata.com</a></td>
</tr>
</tbody>
</table>
# Contents

AccessData Legal and Contact Information ............................................. 2

Contents ........................................................................................................ 7

Chapter 1: Planning to Install FTK ............................................................. 11
   About 32-bit and 64-bit computers ....................................................... 11
   Prerequisites ......................................................................................... 11
      Hardware Considerations ............................................................... 12
   Distributed Processing Guideline Summary ........................................ 13
   Configuration Options ........................................................................ 13
   Choosing a Database Application to Use ............................................. 14
   Planning for a New Installation .......................................................... 14
   Planning for an FTK Upgrade from a Previous Version ...................... 15
   About Installing CodeMeter and Managing Licenses ......................... 15

Chapter 2: Installing FTK .......................................................................... 16
   Process for Installing AccessData Forensic Toolkit ............................ 16
      Download & Preparation ................................................................. 17
      Required Software ......................................................................... 17
      Installing the Database ................................................................... 17
      Installing the FTK Suite ................................................................ 18
         Performing a Default Installation of the FTK Suite ...................... 19
         Performing an Advanced Installation of the FTK Suite ................ 20
      Initializing the FTK Database and Creating an Application Administrator Account .................................................................................................................... 22
   Uninstalling FTK .................................................................................. 23

Chapter 3: Upgrading FTK ........................................................................ 24
   About Upgrading FTK ......................................................................... 24
      About Upgrading PostgreSQL ........................................................ 24
      PostgreSQL Upgrade Instructions ................................................. 24
      About Installing FTK Upgrades and Patches ................................. 25
      About Upgrading, Migrating, and Moving Cases ......................... 25
         Scenarios for Upgrading, Migrating, and Moving Cases ............ 26
      Upgrading Cases ........................................................................... 27
      Migrating Cases to a Newer Version of FTK and Different Database 28
      Moving Cases from One Database to Another ............................... 28
   Backing Up a Case .............................................................................. 30
### About Performing a Backup and Restore on a Multi-Box Installation

- Performing a Backup of a Case
- Restoring a Case
- Configuration for a Multi-box Setup
  - Configuration Overview
  - Create a Service Account
    - Instructions for Domain User Accounts
  - Share the Case Folder
  - Configure Database Services
  - Share the Backup Destination Folder
  - Test the New Configuration

### Chapter 4: Installing Additional Programs

- Installing Language Selector
- Using Language Selector

### Chapter 5: Getting Started with KFF (Known File Filter)

- Introducing KFF
  - About the KFF Server and Geolocation
- About KFF
  - Introduction to the KFF Architecture
  - Components of KFF Data
    - About the Organization of Hashes, Hash Sets, and KFF Groups
    - About Pre-defined KFF Hash Libraries
  - How KFF Works
    - Status Values
    - Hash Sets
    - Higher Level Structure and Usage
  - About KFF Data Formats
    - About the CSV Format
- Installing the KFF Server
- About Installing the KFF Server
- About KFF Server Versions
  - About Upgrading from Earlier Versions
- Process for Installing KFF
- Downloading the Latest KFF Installation Files
- Determining Where to Install the KFF Server
  - AD Lab and AD Enterprise
  - Summation or eDiscovery
- Installing the KFF Server
  - About Installing Cassandra
  - Installing Cassandra
- Configuring the Location of the KFF Server
  - Configuring the KFF Server Location on AD Lab and AD Enterprise
Chapter 1
Planning to Install FTK

This guide details the installation of the components required for the operation of AccessData Forensic Toolkit (FTK).

Also refer to the Release Notes for specific issues regarding installation. The Release Notes are available: http://www.accessdata.com/support/product-downloads/ftk-download-page

About 32-bit and 64-bit computers

Many of the AccessData software components that you install have both 32-bit and 64-bit versions.

Make sure that you know whether you are using a 32-bit or 64-bit computer.

Prerequisites

The following prerequisites apply for installing and running FTK:

- A computer running a supported operating system
  For a list of supported operating systems that you can install FTK on, see the bottom-right panel on the FTK download page: http://www.accessdata.com/support/product-downloads/ftk-download-page
- Minimum hardware and software requirements:
  Download the FTK System Specifications Guide from the FTK download page.
- A supported database
  Choosing a Database Application to Use (page 14)
- A WIBU-SYSTEMS CodeMeter USB or Virtual CmStick
  See Managing Security Devices and Licenses on page 84.
- CodeMeter Runtime software for the CodeMeter Virtual or USB CmStick.
  See Managing Security Devices and Licenses on page 84.
- Evidence Processing Engine
Hardware Considerations

The more powerful the available hardware, the faster FTK can analyze, process and prepare case evidence. Larger evidence files require more processing time than smaller evidence files. AccessData recommends that the various components be installed on separate machines to make more hardware resources available to the program. Thus, while the FTK and database components can be installed on a single workstation, the ideal and recommended configuration uses two workstations connected by a Gigabit Ethernet connection, thus making more hardware resources available to each.

If you want to use KFF with, the KFF Server must be installed on the same computer as the FTK application. See Installing the KFF Server on page 45.

Ideally, the latest CodeMeter Runtime, Language Selector, and License Manager software that AccessData provides should be installed on the same computer as the FTK application.

To further maximize performance, AccessData recommends the following:

- For both the single- and separate-workstation configurations, install the database to a large hard disk drive the database can use exclusively.
- Do not run third-party applications on either the FTK or the database machine that will compete with FTK or the database for hardware resources.
Distributed Processing Guideline Summary

FTK supports Distributed Processing Engines (DPEs). Distributed Processing allows the installation of up to three additional processing engines to share the work load of processing evidence in a case.

Note the following:

- The distributed processing engines (cluster) require significant I/O capacity to properly read the image/evidence. To avoid bottlenecks and failures ensure the evidence is stored in a location with sufficient I/O. Failure notices will appear in the evidence log if capacity is not sufficient.
- To avoid bottlenecks in processing, ensure that there is sufficient I/O bandwidth/capacity into the database and case folder.
- UNC paths must be used for evidence and case folders.
- Make sure the distributed processing engine (DPE) services are running with a user account that has read/write access to the evidence and case folder.
- Ensure a minimum 1 Gigabit network connection is used for all communication in the distributed processing cluster.
- Distributed processing generates a lot of traffic.
- Refer to the AccessData Distributed Processing appendix in the User Guide for additional information on setup and usage of distributed processing.
- If you are installing KFF in a distributed processing environment, you must specify the KFF server by its IP address and not use ‘localhost’. Otherwise you may get incorrect KFF counts.

For More information, see AccessData Distributed Processing (page 103)

Configuration Options

FTK can be set up in three different configurations, each with its own benefits and advantages.

- Single Machine
  FTK and the database are both installed on the same box. It may be helpful in this scenario if the database is installed on a secondary drive to provide better throughput.

- Separate Machines with a new database install
  FTK and the database can be installed on separate boxes or on the same box. If both are installed on the same box, it is recommended that the database be installed either on a separate drive, or on a separate partition from FTK.

- Separate Machines with an existing database install
  If a compatible database is already installed, you can use it with FTK. The installer runs a check for compatibility.

Note: The database software should be installed to a physical system drive. Installing the database in a virtual machine is not supported. Installing the CodeMeter software in a virtual machine is not recommended.

Note: AccessData recommends that you turn off firewalls and anti-virus software during installation.

Important: If installation is being done using remote desktop to Server 2003, the remote connection needs to be established using either the /admin or the /console command.
Choosing a Database Application to Use

FTK requires using one of the following database applications:

<table>
<thead>
<tr>
<th>Database Application</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL 9.0.x, 9.1.6, 9.1.11, 9.1.15, or 9.3.5</td>
<td>PostgreSQL is provided free of charge by AccessData. See Download &amp; Preparation on page 17. For information on upgrading to 9.1.11, see About Upgrading PostgreSQL (page 24).</td>
</tr>
<tr>
<td>Microsoft SQL Server 2012 or 2014</td>
<td>See Configuring and Managing Databases for FTK on page 78.</td>
</tr>
<tr>
<td>Oracle 10.2.0.4</td>
<td>Oracle 11g is not supported. See Best Practices for Using Oracle on page 78.</td>
</tr>
</tbody>
</table>

When you install FTK, you select which database application to use. If you are upgrading from a previous version of FTK, you are not required to use the same database. You can install and migrate cases to a new database application from a different database.

The database must be installed before installing FTK.

PostgreSQL is provided free of charge by AccessData. You can use your own installations of Microsoft SQL or Oracle.

Planning for a New Installation

Planning a New FTK Installation using PostgreSQL

- PostgreSQL 9.3.5 is available free of charge on the FTK download page. See Download & Preparation on page 17.
- You must install PostgreSQL before installing FTK.

Planning a New FTK Installation using Microsoft SQL Server

- You can use either Microsoft SQL Server 2012 or 2014 with FTK.
- Before installing FTK, you must install SQL and configure it so that it will work with FTK. See Best Practices for using Microsoft SQL Server on page 80.

Planning a New FTK Installation using Oracle

- You can use Oracle 10.2.0.4 with FTK.
- You must install Oracle before installing FTK.
- When adding the database, you must configure the Oracle SID as FTK2. See Initializing the FTK Database and Creating an Application Administrator Account on page 22.
- For information about obtaining and applying Oracle Critical Patch Updates, see Best Practices for Using Oracle (page 78).
Planning for an FTK Upgrade from a Previous Version

See Upgrading FTK on page 24.

About Installing CodeMeter and Managing Licenses

See Managing Security Devices and Licenses on page 84.
Chapter 2
Installing FTK

Process for Installing AccessData Forensic Toolkit

There are two discs that ship with FTK:

- The Database and FTK program install disc
- The KFF Server and KFF data install disc.

Each disc has an Autorun.exe to streamline the installation process.

The FTK application can be installed on either the same or different computer as the database.

If you install the FTK application and the database on the same computer, it is considered a one-box, or single-box, install. To perform a one-box install, perform the prescribed steps in the order presented, all on the same computer.

If you install the FTK application and the database on a different computer, it is known as a two-box install. To perform a two-box install, perform the prescribed steps in the order presented, on the specific computer.

Installation Process

<table>
<thead>
<tr>
<th>Step</th>
<th>Computer</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Database</td>
<td>Choose and install a supported database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Installing the Database on page 17.</td>
</tr>
<tr>
<td>2</td>
<td>Database</td>
<td>If using Oracle or Microsoft SQL, optimize your database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Configuring and Managing Databases for FTK on page 78.</td>
</tr>
<tr>
<td>3</td>
<td>FTK application</td>
<td>Install the FTK Suite:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- CodeMeter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Evidence Processing Engine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- FTK application</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Installing the FTK Suite on page 18.</td>
</tr>
<tr>
<td>4</td>
<td>FTK application</td>
<td>Run FTK and initialize the database</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Initializing the FTK Database and Creating an Application</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Administrator Account on page 22.</td>
</tr>
<tr>
<td>5</td>
<td>FTK application</td>
<td>Install other components, such as KFF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Installing Additional Programs on page 36.</td>
</tr>
</tbody>
</table>
Important: For information regarding backup and restore for FTK when the database is installed on a separate box, see “Appendix F Back-up and Restore Case Data on a Two-Box Installation” in the FTK User Guide.

Download & Preparation

You may have installation disks or you can download the required files. Use the following procedure to download the FTK installation files from the AccessData website.

2. On the Product Downloads page, click Forensic Toolkit (FTK).
3. For the version that you want to install, click Download Page.
4. On the Forensic Toolkit (FTK) download page, select the ISO that you want to install. For example, FTK 32-bit or FTK 64-bit.
5. Download the ISO files. (AccessData recommends using a download manager program such as Filezilla.)
6. Verify the MD5 hashes match what is posted on the main FTK download page to ensure there was no data corruption in the download process.
7. Do one of the following:
   - Mount the ISO directly using a program like MagicDisc. AccessData recommends mounting an ISO image for the installation as it eliminates some of the problems associated with burning discs.
   - Burn the ISO to a DVD with a program such as ImgBurn.
     Important: If you install the database from a mounted ISO image, make sure there are no discs in the optical drives before you start the installation.

Required Software

FTK requires

- Microsoft .NET Framework 4.0 Full
- InstallMSDTC

If these are not installed, the FTK installer will install them automatically.

Installing the Database

Before installing FTK, you must have a database installed.

If you do not have one of the supported databases installed, you can install PostgreSQL, which is provided by AccessData.

If you are using Microsoft SQL, Oracle, or PostgreSQL on a different computer, install it before installing the FTK application.

To install PostgreSQL on the same computer as FTK, use the FTK Suite installer.
**Important:** During the installation, you will specify a password that is required for FTK database administrative tasks. Record this password. AccessData cannot recover this password if it is lost.

If using Oracle or Microsoft SQL, optimize your database.
See Configuring and Managing Databases for FTK on page 78.

**Installing the FTK Suite**

When installing FTK, you use the *AccessData FTK Suite* installer. This suite installer can install the following FTK applications:

- CodeMeter Runtime Kit
- PostgreSQL database (on the same computer)
- Evidence Processing Engine
- FTK application

In the installation wizard, you can choose one of two installation methods:

| Default          | This option is a “single-click” installation that installs all of the applications with default settings.  
|                  | This option is used for a single-box installation which is best suited for evaluation only.  
|                  | If a database is already installed, the Advanced option is only available.  
|                  | Note: This installation uses a pre-set PostgreSQL database administrator account detailed below.  
|                  | See Performing a Default Installation of the FTK Suite on page 19.  
|                  | See Initializing the FTK Database and Creating an Application Administrator Account on page 22. |
| Advanced         | This option lets you select which applications to install. It also lets you choose folder locations for the features.  
|                  | If you are not going to install PostgreSQL on the same computer, install your Oracle, Microsoft SQL or PostgreSQL database before installing the FTK suite.  
|                  | See Performing an Advanced Installation of the FTK Suite on page 20. |
Performing a Default Installation of the FTK Suite

To perform a default installation

1. Insert your license dongle into the computer you will be installing FTK on.
2. Using the FTK Install disc or ISO, launch the installation FTK_autorun.exe on the computer where FTK will reside.
   See Download & Preparation on page 17.
3. Click FTK Install to launch the FTK Suite installation wizard.
4. On the Welcome page of the wizard, click Next.
5. On the License Agreement page of the wizard, read the agreement, and accept the license, and click Next.
6. On the Setup Type page of the wizard, click Default.
7. On the PostgreSQL License Agreement page of the wizard, read the agreement, and accept the license, and click Next.
8. If not already installed, the following applications are installed.
   ● CodeMeter
   ● PostgreSQL
   ● Evidence Processing Engine
   ● FTK application
   ● Other prerequisite components
9. When this installation is completed, click Finish.
10. Click the FTK shortcut icon to launch FTK and initialize the database.
    See Initializing the FTK Database and Creating an Application Administrator Account on page 22.
11. (Optional) Install KFF or other products.
    You must initialize the database before you do this step.
    See Installing Additional Programs on page 36.
Performing an Advanced Installation of the FTK Suite

If you are not going to install PostgreSQL on the same computer, install your Oracle, Microsoft SQL or PostgreSQL database before installing the FTK suite.

To perform an advanced installation
1. Insert your license dongle into the computer you will be installing FTK application on.
2. Using the FTK Install disc or ISO, launch the installation $\text{FTK\_autorun.exe}$ on the computer where FTK will reside.
   See Download & Preparation on page 17.
3. Click FTK Install to launch the FTK Suite installation wizard.
4. On the Welcome page of the wizard, click Next.
5. On the License Agreement page of the wizard, read the agreement, and accept the license, and click Next.
6. On the Setup Type page of the wizard, click Advanced.
7. On the Custom Setup page of the wizard, select the features that you want to install.
   - If you already have PostgreSQL installed on the computer, it will skip the database installation.
   - If you want to install PostgreSQL on this computer, select it.
   - If you are using a different database, such as Oracle or Microsoft SQL, or PostgreSQL on a different computer, clear the PostgreSQL option.
8. Click Install.
9. The CodeMeter application, if not already installed, is automatically installed.
10. If needed, install the PostgreSQL database by doing the following:
    10a. On the PostgreSQL Setup Welcome page, click Next.
    10b. On the License Agreement page of the wizard, read the agreement, and accept the license, and click Next.
    10c. Accept the default Destination Folder of the PostgreSQL application files or change it and click Next.
    10d. Accept the default Destination Folder of the PostgreSQL data files or change it and click Next.
    10e. Accept the default PostgreSQL port he server should listen on or change it and click Next.
        Use the default port, usually 5432, unless you need to change it.
        Record the port used.
    10f. On the Optimize for environment page, select the second option for Using PostgreSQL with FTK/Lab and click Next.
    10g. In the PostgreSQL User Create dialog, enter and confirm a password for the PostgreSQL admin user and click Next.
        Important: You are required to provide this password when launching FTK for the first time and when performing certain database administrative tasks.
        Record this password in a secure place.
    10h. To install the PostgreSQL database, click Install.
    10i. When the PostgreSQL installation is completed, click Finish.
11. Install the Evidence Processing Engine by doing the following:
    11a. If required software is required to be installed, click Install.
11c. Complete the Evidence Processing Engine installation wizard.  
Because you are installing the Evidence Processing Engine on the same computer as FTK, do not select the **Install as distributed processing engine** option in the *Destination Folder* window.

12. Install the FTK application by doing the following:

12a. Select the language for the installation and click **OK**.
12b. On the *FTK Installation Welcome* page, click **Next**.
12c. On the *License Agreement* page of the wizard, read the agreement, and accept the license, and click **Next**.
12d. On the *Destination Folder* page of the wizard, use the default path or change the path to a new location, and click **Next**.
12e. To install FTK, click **Install**.
12f. When the FTK installation has completed, click **Finish**.

13. Click **Finish**.

14. Click the FTK shortcut icon to launch FTK and initialize the database.
   See *Initializing the FTK Database and Creating an Application Administrator Account* on page 22.

15. (Optional) Install KFF or other products.
   This step can only be done on the computer where the database resides. You must initialize the database before you do this step.
   See *Installing Additional Programs* on page 36.
Initializing the FTK Database and Creating an Application Administrator Account

The database and application must already be installed prior to this step.

The first time you launch FTK, you specify the database for FTK to use. The application then creates the database schema which is required before any case data can be loaded into the database. You will be prompted to give the location of the database. This option allows a non-local database to be specified even if a local database is present.

After initializing the database, you are prompted to create an Application Administrator account. This account lets you create other user accounts and perform other administrative tasks.

To initialize the FTK database and create an Application Administrator account

1. Click the FTK shortcut icon to open FTK.
2. If FTK does not detect a configured database connection for that version of FTK, you will be prompted to Add Database.
3. In the RDBMS drop-down menu, select the brand of database that you are connecting to.
4. Specify the server hosting the database in the Host field. If the database is on the same computer as FTK, you can leave this field empty.
5. (Optional) Give the database connection a nickname in the Display name field.
6. Specify the database name by doing one of the following:
   - If you are using Oracle, you must configure the Oracle SID to be FTK2.
   - If you are using PostgreSQL or MS SQL Server, for the PostgreSQL dbname or mssql sa, you can use the default values or enter your own value. If you enter your own value, make sure that you record it so that you know the database name.
7. Do not change the Port number fields unless you have a custom database configuration.
8. If you are using MS SQL Server, you can check Use Integrated Security to use your Windows authentication credentials.
9. Click OK. If the connection attempt to the database was successful, the database will be initialized.
10. In the Please Authenticate dialog, log into the database using the database administrator account credentials.
   - If you used the default installation, enter the following credentials: Username: postgres Password: AD@Password
   - If you used the advanced installation or installed a different database, enter your credentials. A successful login initializes the database and opens the Case Manager window.
11. In the Add New User dialog, create an Application Administrator account for this version of the database schema.
   - Enter a name and password.
   - Record this information in a secure place.
12. Click OK.
13. Refer to the User Guide for information on how to configure and use FTK.
Uninstalling FTK

To uninstall FTK, you uninstall the following components:

- AccessData FTK Suite
  - AccessData Forensic Toolkit
  - AccessData Evidence Processing Engine
- Database

**Important:** If you plan on re-installing FTK and want access to your cases, do not delete the database without backing it up.

- Other AccessData components:
  - Code Meter Runtime Kit
  - AccessData License Manager

**Important:** Here are some things to remember when uninstalling FTK.

- Prompts to close running processes will not automatically close as indicated. When a user uninstalls FTK after they have been using the program and have since closed it, the dialog box on uninstall will notify the user that processes are still running and gives an option to close them automatically. If the user selects to have the process close them automatically, it cannot. The uninstall cannot work correctly until the user kills all running FTK processes manually.

- If you uninstall after a successful install, the pointer to the database will be left behind. If you want to re-install and point to a new Oracle location, you need to delete the databases.xml file found in the following path (in Vista):
  
  `[drive]:\ProgramData\AccessData\Products\Forensic Toolkit\FTK Databases.xml`
Chapter 3
Upgrading FTK

About Upgrading FTK

About Upgrading PostgreSQL

PostgreSQL 9.1.13 is now provided on the installation disc. Please be aware of the following:

- If you have a previous version of PostgreSQL, such as 9.1.6, you can upgrade to 9.1.13 but it is not required.
- For new installations, PostgreSQL 9.1.13 is the default database.
- For information about version 9.1.13, see http://www.postgresql.org/docs/9.1/static/index.htm

PostgreSQL Upgrade Instructions

You must follow these instructions or you may no longer have access to your previous cases.

- To upgrade to PostgreSQL 9.1.13:
  - Do not uninstall the previous version of PostgreSQL.
  - Run the PostgreSQL installation from the installation disc.
  - At the Data Folder dialog, specify the same pgData91 folder as used by your existing AccessData PostgreSQL 9.1.6 installation.
  - At the PostgreSQL Port dialog, specify the same port as used by your existing AccessData PostgreSQL 9.1.6 installation.
  - At the Port Substitution dialog, click “Yes” to confirm that you do want to use that port.
About Installing FTK Upgrades and Patches

There are two different upgrade scenarios:

<table>
<thead>
<tr>
<th>Installing a major or minor version of FTK (such as 5.6, 6.0, or 6.1)</th>
<th>When you install a newer major version of FTK (3.0, 4.0, 5.0, 6.0) or a minor version of FTK (3.1, 4.1, 4.2, 5.1, 5.2, 5.3, 5.4, 5.5, 5.6, 6.1), it does not upgrade (replace) the previous version of FTK and both versions are usable as stand-alone products. However, if you want to work with cases that were created with a previous version, you must upgrade or migrate the cases to work with the new version. This scenario has a two-step process: 1. Install the new version of FTK. 2. Upgrade or migrate the cases from a previous version to the new version.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing a patch (such as 5.3.6 or 6.0.3)</td>
<td>If you install a patch (such as 5.6.1 or 6.0.3), it upgrades (replaces) the previous version (5.6.0). You do not need to upgrade your cases to work with the new patch. This scenario has a one-step process: 1. Install the new version of FTK and access cases from the previous version.</td>
</tr>
</tbody>
</table>

About Upgrading, Migrating, and Moving Cases

If you have a previous version of FTK (3.x, 4.x, 5.x), and install a new version (like 5.6), both versions are usable as stand-alone products. However, the two installations do not share cases or instances of the database. When you install a newer major or minor version of FTK, it creates a new database and does not have any cases associated with it. You can upgrade or migrate cases from the previous FTK database to work with the new version.

You can also change the database that FTK is using without changing the version of FTK.

Depending on the situation, you can do one of the following with your existing cases:

- Upgrade - You upgrade a case when you are upgrading to a new version of FTK and you are using the same type and version of the database.
- Migrate - You migrate a case when you are upgrading to a new version of FTK and you are using a different type or version of the database.
- Move - You move a case when you are using the same version of FTK and you are changing to a different type or version of the database.

When you upgrade or migrate a case to a newer version of FTK, the case is copied and the original case is still available for use with the previous version of FTK.

Important: You cannot upgrade cases from version 4.0 or earlier directly to version 5.x. You must first upgrade to version 4.1 or 4.2 and then upgrade to version 5.x.

You can use the DBUPGRADE.EXE utility to perform the first part of a two-step migration of cases from FTK 3.4 through 4.0 to version 5.x. You can use the DBUPGRADE.EXE utility to perform the first part of a two-step migration of cases from FTK 3.4 through 4.0 to version 5.x.

For information on upgrading FTK 3.x to 4.1 or 4.2, contact your Technical Account Manager or Technical Support.

Important Considerations

- Some features supported by newer versions may not be available when reviewing a case that has been upgraded. Depending on the feature, you may need to reprocess some or all of the evidence in the case to be able to use a particular feature.
The following information assumes that you have already created user accounts in the new database.

### Scenarios for Upgrading, Migrating, and Moving Cases

There are several scenarios where you may want to upgrade, migrate, or move your cases. How you upgrade, migrate, or move your cases depends on the source and the desired destination of the cases.

The following table lists the possible scenarios and the general process to perform the upgrade, migration, or move.

<table>
<thead>
<tr>
<th>Scenario Description</th>
<th>Process Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrading a case from FTK 4.2.x or 5.x to FTK 5.6 and using the same type and version of the database.</td>
<td><strong>One-step upgrade process:</strong>&lt;br&gt;1. In FTK 5.1, upgrade the case using the Copy Previous Case feature.&lt;br&gt;See <a href="#">Upgrading Cases</a> on page 27.</td>
</tr>
<tr>
<td>For example:</td>
<td></td>
</tr>
<tr>
<td>• FTK 4.2 with Oracle 10g to FTK 5.6.x with Oracle 10g</td>
<td></td>
</tr>
<tr>
<td>• FTK 4.2 with PostgreSQL 9.1.6 to FTK 5.6.x with PostgreSQL 9.1.x</td>
<td></td>
</tr>
<tr>
<td>Migrating a case from FTK 4.2.x or 5.x to FTK 5.6 and changing to a different type or version of the database.</td>
<td><strong>Two-step migration process:</strong>&lt;br&gt;1. In FTK 4.2.x or 5.0.x, backup the case using the database independent format.&lt;br&gt;2. In FTK 5.0.x, restore the backed-up case.&lt;br&gt;See <a href="#">Migrating Cases to a Newer Version of FTK and Different Database</a> on page 28.</td>
</tr>
<tr>
<td>For example:</td>
<td></td>
</tr>
<tr>
<td>• FTK 4.2 with Oracle to FTK 5.x with either PostgreSQL or SQL</td>
<td></td>
</tr>
<tr>
<td>• FTK 4.2 with PostgreSQL 9.0.x to FTK 5.x with PostgreSQL 9.1.11</td>
<td></td>
</tr>
<tr>
<td>• FTK 4.2 with PostgreSQL 9.0.x to FTK 5.x with SQL</td>
<td></td>
</tr>
<tr>
<td>Moving a case from one type or version of a database to another while using the same version of FTK.</td>
<td><strong>Two-step move process:</strong>&lt;br&gt;1. In FTK 5.0.x, backup the case using the database independent format.&lt;br&gt;2. In FTK 5.0.x, restore the backed-up case.&lt;br&gt;<a href="#">Moving Cases from One Database to Another</a> (page 28)</td>
</tr>
<tr>
<td>For example:</td>
<td></td>
</tr>
<tr>
<td>• FTK 5.x with Oracle to FTK 5.x with either PostgreSQL or SQL</td>
<td></td>
</tr>
<tr>
<td>• FTK 5.x with PostgreSQL to FTK 5.x with SQL or Oracle</td>
<td></td>
</tr>
<tr>
<td>• FTK 5.x with SQL to FTK 5.x with either PostgreSQL or Oracle</td>
<td></td>
</tr>
</tbody>
</table>
Upgrading Cases

If you are upgrading a case from 4.1 and above to 5.0x and above and you are using the same type and version of the database, you perform a one-step upgrade process.

For example:

- Upgrading from FTK 4.1 with Oracle 10g to FTK 5.x with Oracle 10g
- Upgrading from FTK 4.1 with PostgreSQL 9.1.6 to FTK 5.x with PostgreSQL 9.1.6

**Note:** If you are changing either the type or the version of the database, you must perform a two-step migration.

Important Considerations

- You cannot upgrade cases from 3.x or 4.0 to 5.x. You must upgrade to 4.1 or 4.2 first. Then you can upgrade from 4.1 or 4.2 to 5.x. For information on upgrading from 4.0.x or older, contact your Technical Account Manager or Technical Support.
- This version does not support upgrading cases from 2.x. If you have 2.x cases that you want to upgrade, you must first upgrade the cases to 3.0 or newer.
- Some features supported by newer versions may not be available when reviewing a case that has been upgraded. Depending on the feature, you may need to reprocess some or all of the evidence in the case to be able to use a particular feature.

The following information assumes that you have already created user accounts in the new database.

To upgrade a case

1. In FTK 5.x, open the Case Manager.
2. Click Case > Copy Previous Case...
3. On the Copy Case(s) dialog, in the Select Database drop-down menu, select the version of the database from which you would like to copy your case.

**Note:** If prompted to authenticate, enter the system administrator (sys) credentials for the Oracle database and then click OK.

4. Highlight the case(s) which you would like to upgrade into the new database. Use Shift+Click or Ctrl+Click to select more than one case at a time.

**Important:** The selected case(s) must not be in use at the time of upgrade.

5. Click OK.

6. On the Case Attach dialog, use the Case: drop-down menu to view the list of users that are associated to each case.

7. For each case that is upgraded, use the Associate Users control box to map the user names that exists in the previous database (Old User Name) to the appropriate user name(s) that exist in the new database (New User Name).

8. To associate users, do the following:

   8a. Highlight the old user name(s) to which you would like to associate to a username in the new database. Use SHIFT+Click or CTRL+Click to select more than one username at a time.

   8b. Click Associate to...

   8c. Select the user name from the new database to which you would like to associate with the old user names.

9. Click OK.
10. The selected user associations are mapped and the case is copied into the new database.

**Note:** The copied case is written to the same main case folder as the source case. The upgraded case name will be appended with a number to make it unique. For example, My Example Case Name (1).

---

**Migrating Cases to a Newer Version of FTK and Different Database**

You perform a two-step migration process for cases if you are upgrading a case from 4.2 to 5.x and are also changing to a different type or version of the database.

For example:

- Migrating from FTK 4.2 with Oracle to FTK 5.x with PostgreSQL 9.1.6
- Migrating from FTK 4.2 with Oracle to FTK 5.x with Microsoft SQL
- Migrating from FTK 4.2 with PostgreSQL 9.0.x to FTK 5.x with PostgreSQL 9.1.6

**Note:** If you are not changing the type or the version of the database, you can perform a one-step upgrade. See Upgrading Cases on page 27.

When you migrate a case, the original case is maintained for the previous version and a new copy is migrated for use with the new version of FTK.

**To migrate a case from 4.2 or 5.x to 5.x**

1. In FTK 4.2 or 5.x Case Manager, back up the case using the database independent format. See Backing Up a Case on page 30.
2. Open the Case Management interface (connected to the new database).
3. Restore your cases to the new database. See Restoring a Case on page 32.

**Moving Cases from One Database to Another**

Your FTK 5.x cases can be moved from one database type or version to another.

For example:

- Moving cases in FTK 5.x with PostgreSQL 9.1.6 to FTK 5.x with PostgreSQL 9.1.11
- Moving cases in FTK 5.x with Oracle to FTK 5.x with either PostgreSQL or SQL
- Moving cases in FTK 5.x with SQL to FTK 5.x with either PostgreSQL or Oracle

To move cases, do the following:

- Backup each case that you want moved.
- Restore each case to the new database.
To move cases from database to another

1. Open the Case Management interface.
2. Back up ALL cases that need to be moved.
   See Backing Up a Case on page 30.
3. Connect to the new database. If the instance you are running has been connected to a database previously, you will need to follow these steps to switch default databases:
   3a. After all cases have been backed up successfully, close the Case Manager.
   3b. Shut down the database service(s). (In Windows, you can use the services.msc management snap-in to stop the database services.)
   3c. Ensure the new database is up and accepting connection requests.
   3d. Launch the application (you should receive a message stating that it was unable to connect to the database).
   3e. Connect to the new database and complete the initialization process. For help, see “Initializing the Database.”
4. Open the Case Management interface (connected to the new database).
5. Restore your cases to the new database.
   See Restoring a Case on page 32.
Backing Up a Case

About Performing a Backup and Restore on a Multi-Box Installation

If you have installed the Examiner and the database on separate boxes, or if you have case folders on a different box than the application, there are special considerations you must take into account. For instructions on how to back up and restore in this environment, see Configuring a Multi-box Setup in the User Guide.

Performing a Backup of a Case

At certain milestones of an investigation, you should back up your case to mitigate the risk of an irreversible processing mistake or perhaps case corruption.

Case backup can also be used when migrating or moving cases from one database type to another. For example, if you have created cases using 4.1 in an Oracle database and you want to upgrade to 5.0.x and migrate the case(s) to a PostgreSQL database. Another example is if you have created cases using 5.0.x in an Oracle database and you want to move the case(s) to the same version that is running a PostgreSQL database.

When you back up a case, the case information and database files (but not evidence) are copied to the selected destination folder. AccessData recommends that you store copies of your drive images and other evidence separate from the backed-up case.

Important: Case Administrators back up cases and must maintain and protect the library of backups against unauthorized restoration, because the user who restores an archive becomes that case’s administrator.

Note: Backup files are not compressed. A backed-up case requires the same amount of space as that case’s database table space and the case folder together.

Starting in 4.2, all backups are performed using the database independent format rather than a native format. The database independent format facilitates migrating and moving cases to a different database application or version. You can perform a backup using a native format using the dbcontrol utility. For more information, contact AccessData Technical Support.

Important: Do not perform a backup of a case while any data in that case is being processed.

To back up a case

1. In the Case Manager window, select the case to back up. You can use Shift + Click, or Ctrl + Click to select multiple cases to backup.

2. Do one of the following:
   - Click Case > Backup > Backup.
   - Right-click on the case in the Cases list, and click Backup.

3. In the field labeled Backup folder, enter a destination path for the backup files.

   Important: Choose a folder that does not already exist. The backup will be saved as a folder, and when restoring a backup, point to this folder (not the files it contains) in order to restore the case.

4. If you are using 4.1 to backup a case in order to migrate it to 4.2, make sure that you select Use database independent format.
   - In 4.2, all backups are performed using the database independent format.
5. (Optional) Back up the Summation or Resolution1 application database.
   If you have a licence for Summation or Resolution1, when you back up a case, you can also select to backup the Summation or Resolution1 application database by doing the following:
   5a. Click App DB..
   5b. Specify the App DB properties and credentials.
6. Click OK.

**Note:** The following information may be useful:

- Each case you back up should have its own backup folder to ensure all data is kept together and cannot be overwritten by another case backup. In addition, AccessData recommends that backups be stored on a separate drive or system from the case, to reduce space consumption and to reduce the risk of total loss in the case of catastrophic failure (drive crash, etc.).
- The absolute path of the case folder is recorded. When restoring a case, the default path is the original path. You can choose the default path, or enter a different path for the case restore.
Restoring a Case

When your case was backed up, it was saved as a folder. The folder selected for the backup is the folder you must select when restoring the backup.

Note: Do not use the Restore... function to attach an archive (instead use Attach...).

To restore a case
1. Open the Case Manager window.
2. Do either of these:
   - Click Case > Restore > Restore.
   - Right-click on the Case Manager case list, and click Restore > Restore.
3. Browse to and select the backup folder to be restored.
4. (Optional) Select Specify the location of the DB files and browse to the path to store the database files for this case.
   4a. Select In the case folder to place the database files in subfolder of the case folder.
5. You are prompted if you would like to specify a different location for the case folder. The processing status dialog appears, showing the progress of the archive. When the archive completes, close the dialog.

Configuration for a Multi-box Setup

A multi-box setup is a configuration where all components are not installed or contained on the same computer. For example, you may have the database installed on a separate computer from the application, or the application and the database are installed on one computer and the case files are stored on a different computer.

By default, a multi-box installation is not configured to allow the user to back up and restore case information. Some configuration changes must be performed manually by the system administrator to properly configure a multi-box installation. Please note that the steps required to complete this configuration differ slightly for domain systems than for workgroup systems.

Configuration Overview

The following steps are required before you can perform multi-box case back ups and restoration.

- Create a service account common to all systems involved. See Create a Service Account on page 33.
- Share the case folder and assign appropriate permissions. See Share the Case Folder on page 33.
- Configure the database services to run under service account. See Configure Database Services on page 34.
- Share back up destination folder with appropriate permissions. See Share the Backup Destination Folder on page 35.
**Note:** When prompted to select the backup destination folder, always use the UNC path of that shared folder, even when the backup destination folder is local.

Each of these items is explained in detail later in this chapter.

**Create a Service Account**

To function in a distributed configuration, all reading and writing of case data should be performed under the authority of a single Windows user account. Throughout the rest of this document, this account is referred to as the “service account.” If all the systems involved are members of the same domain, choosing a domain user account is the recommended choice. If not all of the systems are members of the same domain, then you can configure “Mirrored Local Accounts” as detailed in the following steps:

**To set up Mirrored Local Accounts**

1. On the Examiner host system, create (or identify) a local user account.
2. Ensure that the chosen account is a member of the Local Administrators group.
3. On the database host system, create a user that has the exact same username and password as that on the Examiner host system.
4. Ensure that this account is also a member of the Local Administrators group on the database host system.

**Instructions for Domain User Accounts**

Choose (or create) a domain user account that will function as the service account. Verify that the chosen domain user has local administrator privilege on both the Examiner host system and the database host system.

**To verify the domain user account privileges**

1. Open the “Local Users and Groups” snap-in.
2. View the members of the Administrators group.
3. Ensure that the account selected earlier is a member of this group (either explicitly or by effective permissions).
4. Perform this verification for both the examination and the database host systems.

**Share the Case Folder**

On the system hosting the Examiner, create a network share to make the main case folder available to other users on the network. The case folder is no longer assigned by default. The user creating the case creates the case folder. It is that folder that needs to be shared.

For this example, it is located at the root of the Windows system volume, and the pathname is:

```
C:\FTK-Cases.
```

**To share the case folder**

1. Before you can effectively share a folder in Windows you must make sure that network file sharing is enabled. Windows XP users should disable Simple File Sharing before proceeding. Windows Vista/7
users will find the option in the Sharing and Discovery section of the Network and Sharing Center. If you encounter any issues while enabling file sharing, please contact your IT administrator.

2. Open the Properties dialog for the case folder.
3. Click the Sharing tab to share the folder.
4. Edit the permissions on both the Sharing and Security tabs to allow the one authoritative user Full Control permissions.
5. Test connectivity to this share from the database system:
   5a. Open a Windows Explorer window on the system hosting the database.
   5b. Type `\servername\sharename` in the address bar, where “servername” = the hostname of the Examiner host system, and “sharename” = the name of the share assigned in Step 1.
   For example: If the name of the system hosting the Examiner is ForensicTower1 and you named the share “FTK-Cases” in Step #1 above, the UNC path would be `\forensictower1\FTK-Cases`.
   5c. Click OK. Check to see if the contents of the share can be viewed, and test the ability to create files and folders there as well.

**Configure Database Services**

To ensure access to all the necessary resources, the services upon which the database relies must be configured to log on as a user with sufficient permissions to access those resources.

**To configure the database service(s) to Run As [ service account ]**

1. On the database server system, open the Windows Services Management console:
   1a. Click Start > Run.
   1b. Type `services.msc`.
   1c. Press Enter.
2. Locate the following services:
   Oracle
   - Oracle TNS Listener service listed as OracleFTK2TNSListener or OracleAccessDataDBTNSListener (Found on Oracle System)
   - OracleServiceFTK2 (Found on Oracle System)
   PostgreSQL
   - postgresql-x64-9.0
     or
   - postgresql-x86-9.0
3. Open the properties of the service and click the Log On tab.
4. Choose This account.
5. Click Browse to locate the service account username on the local system or domain. Ensure that “From this location” displays the appropriate setting for the user to be selected. Note that “Entire Directory” is used to search for a domain user account, while the name of your system will be listed for a workgroup system user.
6. In the object name box, type in the first few letters of the username and click Check Names. Highlight the desired username. Click OK when finished.
7. Enter the current password for this account and then enter it again in the Confirm Password box. Click Apply and then OK.
8. Repeat Steps #3-8 for each database service.
9. Restart database service(s) when finished.

**Share the Backup Destination Folder**

Using the same steps as when sharing the main case folder, share the backup destination folder. Use the UNC path to this share when performing backups. For a two-box backup to work correctly, you must use a single UNC path that both the examiner, and the database application have read/write access to.

**Test the New Configuration**

**To test the new configuration**

1. Launch the Case Manager and log in normally.
2. Select (highlight) the name of the case you want to backup.
   2a. Click **Case > Back up**.
   2b. Select a back up destination folder.

   **Note:** The path to the backup location must be formatted as a UNC path.

The *Data Processing* window opens, and when the progress bar turns green, the backup is complete. If the *Data Processing* window results in a red progress bar (sometimes accompanied by “Error 120”), the most likely cause is that the database service does not have permission to write to the backup location. Please double check all the steps listed in this document.
Chapter 4
Installing Additional Programs

You can install the following applications

- Language Selector (See Installing Language Selector on page 36.)
- Known File Filter - KFF (See Getting Started with KFF (Known File Filter) on page 39.)
- License Manager (See Managing Security Devices and Licenses on page 84.)
- PRTK (See the Password Recovery Toolkit and Distributed Network Attack User Guide)
- Registry Viewer (See the Registry Viewer User Guide)
- Imager (See the FTK Imager User Guide)

Installing Language Selector

To change to another supported language other than the default English (United States) that ships with FTK, Language Selector must be installed.

To install Language Selector

1. From the FTK install disc Autorun Main Menu, click Install Other Products, then click Install Language Selector.
2. The Language Selector Installer runs. Click Next to continue.
3. Read and accept the License Agreement. Click Next to continue.
4. Click Finish.

Using Language Selector

Language Selector has a very simple interface.

To run Language Selector

1. Do one of the following:
   - Click Start > All Programs > AccessData > Language Selector > Language Selector.
   - Click the Language Selector Icon on your desktop.
2. Click the **Select Languages** drop-down to select the language to use. Languages to choose from are as follows: The "Products supporting this language" text box indicates the AccessData programs that will be affected by the language selection.

<table>
<thead>
<tr>
<th>Language Selector Supported Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Chinese (Simplified, PRC)</td>
</tr>
<tr>
<td>• Dutch (Netherlands)</td>
</tr>
<tr>
<td>• English (United States)</td>
</tr>
<tr>
<td>• French (France)</td>
</tr>
<tr>
<td>• German (Germany)</td>
</tr>
<tr>
<td>• Italian (Italy)</td>
</tr>
<tr>
<td>• Japanese (Japan)</td>
</tr>
</tbody>
</table>

The File menu contains two choices:
- Select Language
- Exit

The Help menu contains one choice:
- About — Provides version and copyright information.

3. Click **Save Settings** to save selections and close Language Selector.
Chapter 5
Getting Started with KFF (Known File Filter)

Introducing KFF

This document contains the following information about understanding and getting started using KFF (Known File Filter) with products 6.3 and later. If you are using products version 6.2 and earlier, refer to that version’s documentation.

**Important:** AccessData applications versions 6.3 and later use a new KFF architecture. If you are using one of the following applications version 6.3 or later, you must install and implement the new KFF architecture:

- Forensics products (FTK, FTK Pro, AD Lab, AD Enterprise)
- Summation
- eDiscovery

See What has Changed in Version 6.3 on page 72.

- About KFF (page 39)
- Installing the KFF Server (page 43)
- Configuring the Location of the KFF Server (page 49)
- Migrating Legacy KFF Data from Previous Versions (page 52)
- Importing KFF Data (page 55)
- Installing KFF Updates (page 66)
- Uninstalling KFF (page 65)
- KFF Library Reference Information (page 67)
- What has Changed in Version 6.3 (page 72)

**About the KFF Server and Geolocation**

Geolocation (GeoIP) data is used for the Geolocation Visualization feature of several AccessData products.

**Important:** In versions 6.3 and later, Geolocation data is installed automatically and independently and is no longer tied to KFF.
About KFF

KFF (Known File Filter) is a utility that compares the file hash values of known files against the files in your project. The known files that you compare against may be the following:

- Files that you want to ignore, such as operating system or application files
- Files that you want to be alerted about, such as malware or other contraband files

The hash values of files, such as MD5, are based on the file’s content, not on the file name or extension. This helps you identify files even if they are renamed.

Using KFF during your analysis can provide the following benefits:

- Immediately identify and ignore 40-70% of files irrelevant to the project.
- Immediately identify known contraband files.

Introduction to the KFF Architecture

There are two distinct components of the KFF architecture:

- KFF Server - The KFF Server is the component that is used to store and process the KFF data against your evidence. After you install the KFF Server, you import your KFF data into it. See Installing the KFF Server on page 43.
- KFF Data - The KFF data are the hashes of the known files that are compared against the files in your project. The KFF data is organized in KFF Hash Sets and KFF Groups. The KFF data can be comprised of hashes obtained from pre-configured libraries (such as NSRL) or custom hashes that you configure yourself. See Components of KFF Data on page 39.

Components of KFF Data

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hash</td>
<td>The unique MD5 or SHA-1 hash value of a file. This is the value that is compared between known files and the files in your project.</td>
</tr>
<tr>
<td>Hash Set</td>
<td>A collection of hashes that are related somehow. The hash set has an ID, status, name, vendor, package, and version. In most cases, a set corresponds to a collection of hashes from a single source that have the same status.</td>
</tr>
<tr>
<td>Group</td>
<td>KFF Groups are containers that are used for managing the Hash Sets that are used in a project. KFF Groups can contain Hash Sets as well as other groups. Projects can only use a single KFF Group. However, when configuring your project you can select a single KFF Group which can contain nested groups.</td>
</tr>
<tr>
<td>Status</td>
<td>The specified status of a hash set of the known files which can be either Ignore or Alert. When a file in a project matches a known file, this is the reported status of the file in the project.</td>
</tr>
</tbody>
</table>
About the Organization of Hashes, Hash Sets, and KFF Groups

Hashes, such as MD5, SHA-1, etc., are based on the file’s content, not on the file name or extension.

You can also import hashes into the KFF Server in .CSV format.

For FTK-based products, you can also import hashes into the KFF Server that are contained in .TSV, .HKE, .HKE.TXT, .HDI, .HDB, .hash, .NSRL, or .KFF file formats.

You can also manually add hashes.

Hashes are organized into Hash Sets. Hash Sets usually include hashes that have a common status, such as Alert or Ignore.

Hash Sets must be organized into to KFF Groups before they can be utilized in a case or project.

About Pre-defined KFF Hash Libraries

There are pre-configured hash sets currently available for KFF that come from federal government agencies and are available in KFF libraries.

See About KFF Pre-Defined Hash Libraries on page 67.

You can use the following KFF libraries:

- NIST NSRL
  See Importing the NIST NSRL Library on page 60.
- NDIC HashKeeper (Sept 2008)
  See Importing the NDIC Hashkeeper Library on page 64.
- DHS (Jan 2008)
  See Importing the DHS Library on page 64.
- For law enforcement users using forensic products, you can also use Project Vic libraries.
  See Using Project VIC on page 318.

It is not required to use a pre-configured KFF library in order to use KFF. You can configure or import custom hash sets. See your application’s Admin Guide for more information.
**How KFF Works**

The Known File Filter (KFF) is a body of MD5 and SHA1 hash values computed from electronic files. Some predefined data is gathered and cataloged by several US federal government agencies or you can configure your own. KFF is used to locate files residing within project evidence that have been previously encountered by other investigators or archivists. Identifying previously cataloged (known) files within a project can expedite its investigation.

When evidence is processed with the MD5 Hash (and/or SHA-1 Hash) and KFF options, a hash value for each file item within the evidence is computed, and that newly computed hash value is searched for within the KFF data. Every file item whose hash value is found in the KFF is considered to be a known file.

**Note:** If two hash sets in the same group have the same MD5 hash value, they must have the same metadata. If you change the metadata of one hash set, all hash sets in the group with the same MD5 hash file will be updated to the same metadata.

The KFF data is organized into Groups and stored in the KFF Server. The KFF Server service performs lookup functions.

**Status Values**

In order to accelerate an investigation, each known file can be labeled as either Alert or Ignore, meaning that the file is likely to be forensically interesting (Alert) or uninteresting (Ignore). Other files have a status of Unknown.

The Alert/Ignore designation can assist the investigator to hone in on files that are relevant, and avoid spending inordinate time on files that are not relevant. Known files are presented in the Overview Tab’s File Status Container, under “KFF Alert files” and “KFF Ignorable.”

**Hash Sets**

The hash values comprising the KFF are organized into hash sets. Each hash set has a name, a status, and a listing of hash values. Consider two examples. The hash set “ZZ00001 Suspected child porn” has a status of Alert and contains 12 hash values. The hash set “BitDefender Total Security 2008 9843” has a status of Ignore and contains 69 hash values. If, during the course of evidence processing, a file item’s hash value were found to belong to the “ZZ00001 Suspected child porn” set, then that file item would be presented in the KFF Alert files list. Likewise, if another file item’s hash value were found to belong to the “BitDefender Total Security 2008 9843” set, then that file would be presented in the KFF Ignorable list.

In order to determine whether any Alert file is truly relevant to a given project, and whether any Ignore file is truly irrelevant to a project, the investigator must understand the origins of the KFF’s hash sets, and the methods used to determine their Alert and Ignore status assignments.

You can install libraries of pre-defined hash sets or you can import custom hash sets. The pre-defined hash sets contain a body of MD5 and SHA1 hash values computed from electronic files that are gathered and cataloged by several US federal government agencies.

See About KFF Pre-Defined Hash Libraries on page 67.
Higher Level Structure and Usage

Because hash set groups have the properties just described, and because custom hash sets and groups can be defined by the investigator, the KFF mechanism can be leveraged in creative ways. For example, the investigator may define a group of hash sets created from encryption software and another group of hash sets created from child pornography files and then apply only those groups while processing.

About KFF Data Formats

When importing KFF data, you can import the following file formats:

- CSV file format
- Forensics products: .HDB, .HKE, .KFF, .XML, .HASH file formats
- Forensics products used by law enforcement: Project VIC JSON file format

About the CSV Format

When you import or export KFF data, you can import from or export to a CSV format. When you use the .CSV format, you use a single .CSV file at a time. The .CSV file can contain hashes, Hash Sets and KFF Groups that you import or export.

See Components of KFF Data on page 39.

<table>
<thead>
<tr>
<th>Using the CSV format</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exporting to CSV format</strong></td>
<td>When you export KFF data using the CSV format, you can export specific pieces of KFF data, such as one or more Hash Sets or one or more KFF Groups. The exported CSV contains the hashes as well as all of the information about any associated Hash Sets and KFF Groups. Each export is contained in one .CSV file. CSV files can be easily viewed and can be manually edited.</td>
</tr>
<tr>
<td><strong>Importing from CSV format</strong></td>
<td>When you import a CSV file, the data in the file is data is added to your existing KFF data. The CSV file can be a simple file containing only the hashes of files, or it can contain additional information about Hash Sets and KFF Groups. For example, suppose you manually created four Hash Sets and one KFF Group. That would be the only contents in your KFF Server. Suppose you import a .CSV file that contains five hash sets and two KFF Groups. They will be added together for a total of nine Hash Sets and three KFF Groups. To import .CSV files, you can do either of the following:</td>
</tr>
<tr>
<td></td>
<td>- Use the KFF Import feature in your application. See Using the Known File Feature chapter.</td>
</tr>
<tr>
<td></td>
<td>- Use the stand-alone KFF Import Utility. See Importing KFF Data on page 55.</td>
</tr>
</tbody>
</table>

To view a sample of a .CSV file that contains binaries and Hash Sets and KFF Groups, perform a CSV export and view the file in Excel. You can also use the format of CSV files that were exported in previous versions.
Installing the KFF Server

About Installing the KFF Server

In order to use KFF, you must first install and configure a KFF Server.

- For product versions 6.3 and later, you install a KFF Server by installing Apache Cassandra.
- For product versions 5.6 - 6.2, you install a KFF Server by installing the AccessData Elasticsearch.

Where you install the KFF Server depends on the product you are using with KFF.

See Determining Where to Install the KFF Server on page 45.

About KFF Server Versions

The KFF Server (AccessData Elasticsearch Windows Service) may be updated from time to time. It is best to use the latest version.

<table>
<thead>
<tr>
<th>Product Version</th>
<th>KFF Server</th>
<th>Released</th>
<th>Installation Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.3</td>
<td>Apache Cassandra Version 3.11</td>
<td>October 2017 with 6.3 versions of FTK-based products Summation eDiscovery</td>
<td>See Determining Where to Install the KFF Server on page 45.</td>
</tr>
</tbody>
</table>

About Upgrading from Earlier Versions

If you have used KFF with applications with a previous KFF Server architecture, you can migrate your legacy KFF data to the new architecture.

See Migrating Legacy KFF Data from Previous Versions on page 52.
Process for Installing KFF

The process for installing KFF is as follows:

1. Downloading the Latest KFF Installation Files (page 44)
2. Determining Where to Install the KFF Server (page 45)
3. Installing the KFF Server (page 47)
4. Configuring the KFF Server location:
   - Configuring the KFF Server Location on AD Lab and AD Enterprise (page 49)
   - Configuring the KFF Server Location on Summation or eDiscovery (page 50)
5. (Optional) Upgrading or importing KFF data.
   - See Migrating Legacy KFF Data from versions 5.5 and earlier on page 53.
   - About Importing KFF Data (page 55)
   - Importing Pre-defined KFF Data Libraries (page 59)

Downloading the Latest KFF Installation Files

You can download ISO files which has the latest KFF files. Files may be updated from time to time.

To download the latest KFF Installation Files

1. Go to the AccessData Current Releases - Digital Forensics product download page. You can also download the file from the FTK or AD Lab product download pages.
2. Click the following:
   - Known File Filter (KFF) Compatible with 6.3 and above.
3. Do one of the following:
   - To download the KFF Server files, and utilities, click KFF for all 6.3 products.
   - To download the DHS library, click KFF DHS.
   - To download the NDC library, click KFF NDIC.
   - To download the NSRL, you can use files from AccessData or you can access them from www.nist.gov. See Importing the NIST NSRL Library Files from AccessData on page 62.
4. Click Download Now.
Determining Where to Install the KFF Server

Where you install the KFF Server depends on the application and environment you are running.

- For FTK and FTK Pro applications, the KFF Server must be installed on the same computer that runs the FTK Examiner application.
- For AD Lab and AD Enterprise, applications, the KFF Server is generally installed on a different computer that runs the Examiner application.
- For Summation or eDiscovery, the KFF Server may be installed on either the same computer as the application or on a remote computer. For large environments, it is recommended that the KFF Server be installed on a dedicated computer.

After installing the KFF Server, you configure the application with the location of the KFF Server.

See Configuring the Location of the KFF Server on page 49.

AD Lab and AD Enterprise

With AD Lab and Enterprise, you generally install the KFF Server on a different computer than the application.

Special Configuration Steps for KFF

When you install the KFF Server on a different computer than the application you perform special configuration steps by doing the following:

- Configure the KFF Server location.
  See Configuring the KFF Server Location on AD Lab and AD Enterprise on page 49.
- Application version 6.3 and later:
  - During the installation of Cassandra, you must enable and configure Remote Access.
    See Installing the KFF Server on page 47.
  - If you installed Cassandra without enabling remote access, you can manually configure Cassandra.
    See Manually Configuring Remote Setting for Cassandra on page 51.
Summation or eDiscovery

With Summation or eDiscovery, you may have one of the following environments. The type of environment determines where and how to configure the KFF Server.

<table>
<thead>
<tr>
<th>Environment</th>
<th>KFF Server Location and Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Server</td>
<td>All components of the application are installed on a single server.</td>
</tr>
<tr>
<td></td>
<td>• You can install the KFF Server on this server or a different remote computer.</td>
</tr>
<tr>
<td></td>
<td>• If you install the KFF Server on the same server, no special configuration for KFF is needed.</td>
</tr>
<tr>
<td></td>
<td>• If you install the KFF Server on a remote computer, you must perform special configuration steps for KFF.</td>
</tr>
<tr>
<td>Distributed Components with Local Processing</td>
<td>Components of the application are installed on multiple servers. For example, the MAP component is on one server and other application components, such as WCF Services and Local Processing are installed on a separate computer.</td>
</tr>
<tr>
<td></td>
<td>• You can install the KFF Server on the same server as WCF Services and Local Processing or on a different remote computer.</td>
</tr>
<tr>
<td></td>
<td>• If you install the KFF Server on the same server, no special configuration for KFF is needed.</td>
</tr>
<tr>
<td></td>
<td>• If you install the KFF Server on a remote computer, you must perform special configuration steps for KFF.</td>
</tr>
<tr>
<td>Distributed Processing Manager and Engines</td>
<td>You have installed the Distributed Processing Manager and Distributed Processing Engines.</td>
</tr>
<tr>
<td></td>
<td>• You can install the KFF Server on any computer.</td>
</tr>
<tr>
<td></td>
<td>• You must perform special configuration steps for KFF.</td>
</tr>
<tr>
<td>Dedicated KFF Server</td>
<td>For performance, you can install the KFF Server on a dedicated computer.</td>
</tr>
<tr>
<td></td>
<td>• You must perform special configuration steps for KFF.</td>
</tr>
</tbody>
</table>

If you do not need to perform special configuration steps, you can use default settings.

Special Configuration Steps for KFF

If needed, when you perform special configuration steps, you must do the following:

- Configure the KFF Server location by editing two application configuration files.
  See Configuring the KFF Server Location on Summation or eDiscovery on page 50.
- Application version 6.3 and later:
  - During the installation of Cassandra, you must enable and configure remote access.
    See Installing the KFF Server on page 47.
  - If you installed Cassandra without enabling remote access, you can manually configure Cassandra.
    See Manually Configuring Remote Setting for Cassandra on page 51.
**Installing the KFF Server**

How you install the KFF Server depends on version of the product you are running.

For product versions 6.3 and later, you install the KFF Server by installing Apache Cassandra 3.11.

**About Installing Cassandra**

For product versions 6.3 and later, you install the KFF Server by installing Apache Cassandra 3.11.

**Cassandra Prerequisites**

When you install Cassandra, it will also install Python 2.7.13 if needed.

**Important:** In order to install Cassandra, you must have 64-bit Java for Windows version 8. No other version of Java (7 or 9) is currently supported.

To install Java, go to:


If you are using a 32-bit browser, you may automatically download the 32-bit version. You must use the 64-bit version.

**Important:** The current release of the Apache Cassandra database used in the KFF Server is not compatible with the Java version 8 update 161. If you have already applied the 161 update you will need to revert to a previous release of version 8 in order for the Apache Cassandra database to function. (13026)

**Cassandra and Firewalls**

During the installation, if you check the box to *Enable Remote Access*, the installer creates an inbound exception rule for the port entered in the Cassandra installer (if the rule has not already been created).

The rule has the following attributes:

- name = AccessData Cassandra Remote Access Port
- direction = in
- program = "<install directory>Cassandra\bin\daemon\prunsrv.exe"
- local port = 9042 (or whatever the user entered)
- protocol = tcp

If you uninstall Cassandra, the installer checks to see if Enable Remote Access was checked during install, and if it was, the installer looks for the above firewall rule using the 5 listed attributes, and if it finds the rule, it removes it from the firewall.
Installing Cassandra

To install Cassandra

1. Select the computer that you want to install Cassandra on.
   See Determining Where to Install the KFF Server on page 45.
2. If needed, install 64-bit Java 8.
3. Do one of the following to access AccessData_Cassandra_Installer.exe:
   - Disk
   - Download
4. Launch AccessData_Cassandra_Installer.exe.
5. If needed, install Python 2.7.
6. On the Welcome page, click Next.
7. Accept the license terms and click Next.
8. Verify or change the the Destination Folder and click Next.
   See Determining Where to Install the KFF Server on page 45.
   Important: If installing for FTK, do not enable Remote Access. FTK requires a setting of localhost.
   9b. In the RPC_Address field, enter the IP address of the computer you are installing on.
      For example, 10.10.10.10.
   9c. In the Native Transport Port Number field, leave the default 9042.
   9d. Click Next.
      If you do not enable Remote Access during installation, you can manually configure it later.
      See Manually Configuring Remote Setting for Cassandra on page 51.
10. If you enabled Remote Access, set the User Credentials for the service and click Next.
11. Click Install to perform the installation.
12. Click Finish.
13. If your AccessData application is already open, restart it.
Configuring the Location of the KFF Server

After installing the KFF Server, on the computer running the application, such as Summation, eDiscovery, FTK, or AD Lab, you configure the location of the KFF Server.

Do one of the following:

- Configuring the KFF Server Location on AD Lab and AD Enterprise (page 49)
- Configuring the KFF Server Location on Summation or eDiscovery (page 50)
- Manually Configuring Remote Setting for Cassandra (page 51)

Configuring the KFF Server Location on AD Lab and AD Enterprise

If running FTK, you use default settings.

If running with AD Lab or AD Enterprise, and if not using default settings, before using KFF, you must configure the location of the KFF Server.

Important: To configure KFF, you must be logged in with Admin privileges.

To view or edit KFF configuration settings

1. In the Case Manager, click Tools > Preferences > Configure KFF.
2. You can set or view the address of the KFF Server.
   - If you installed the KFF Server on the same computer as the application, this value will be localhost.
   - If you installed the KFF Server on a different computer, identify the KFF server.
3. Click Test to validate communication with the KFF Server.
4. Click Save.
5. Click OK.
Configuring the KFF Server Location on Summation or eDiscovery

When using the KFF Server with Summation or eDiscovery, two configuration files must point to the KFF Server location.

**Important:** If you are upgrading to 6.3 or later from 6.2 or earlier, the syntax of and the port values for the KFF Server have changed. If the KFF Server is not being recognized, make sure that the two config files are correct.

See [What has Changed in Version 6.3](#) on page 72.

<table>
<thead>
<tr>
<th>KFF Server Location scenarios</th>
</tr>
</thead>
<tbody>
<tr>
<td>If one of the following is true, you can use the default settings and the KFF Server location is configured as “localhost”.</td>
</tr>
<tr>
<td>- Your Summation or eDiscovery installation is on a single server</td>
</tr>
<tr>
<td>- Your Summation or eDiscovery installation is on multiple servers, and you install the KFF Server on the same server that is running WorkManager</td>
</tr>
<tr>
<td>If needed, you can verify the settings without changing them.</td>
</tr>
</tbody>
</table>

| If one of the following is true, you must manually specify the location of the KFF Server: |
| - If you change the location of your KFF Server |
| - If you install the KFF Server on a different computer than is running WorkManager |
| - If you are using distributed processing |
| For KFF processing to work correctly in this situation, change the the **KFFServerURL** setting from “localhost” to the actual IP address. |

**Manually Verifying or Configuring the KFF Server Location on products 6.3 and later**

1. Configure `AdgWindowsServiceHost.exe.config`:
   1a. On the computer running the work manager service, go to `C:\Program Files\AccessData\Common\FTK Business Services`.
   1b. Open `AdgWindowsServiceHost.exe.config`.
   1c. Find the line `<add key="KFFServerUrl" value="localhost:9042" />`. 
      *Note: 9042 is the default port for Cassandra.*
   1d. If needed, change `localhost` to be the location IP address of your KFF server.
      For example, value="10.10.10.10:9042"
      Otherwise, leave as localhost.
   1e. Leave the following line unchanged:
      `<add key="KFFServerDBType" value="Cassandra" />`
   1f. Save and close the file.
   1g. If you changed the file, restart the AccessData Business Services Common service.
2. Configure Infrastructure.WorkExecutionServices.Host.exe.config:
   2a. On the computer running the work manager service, go to C:\Program Files\AccessData\eDiscovery\WorkManager.
   2c. Find the line `<add key="KFFServerUrl" value="localhost:9042" />`. Note: 9042 is the default port for Cassandra.
   2d. If needed, change localhost to be the location IP address of your KFF server. For example, value="10.10.10.10:9042"
       Otherwise, leave as localhost.
   2e. Leave the following line unchanged:
       `<add key="KFFServerDBType" value="Cassandra" />
   2f. Save and close the file.
   2g. If you changed the file, restart the AccessData Work Manager service.
3. Migrate or Import your KFF Hash Data.
   See About Importing KFF Data on page 55.

**Manually Configuring Remote Setting for Cassandra**

In some situations Cassandra needs to be configured to enable Remote Access.

See Determining Where to Install the KFF Server on page 45.

During the installation of Cassandra there is the option to Enable Remote Access and then set the RPC_Address (the IP address of the computer that Cassandra is installed on).

If you set these settings correctly during the installation, no further configuration is needed.

However, if you did not enable remote access or make a change, you can manually configure the remote settings for Cassandra.

**Note:** Use an editor that supports YAML files.

**To manually configuring remote settings for Cassandra**

1. Go to the location that you installed Cassandra.
    By default, it is C:\Program Files\AccessData\Cassandra.
2. Open the /conf folder.
3. Edit the cassandra.yaml file.
4. Search for rpc_address:
5. Change the address from local host to the IP or DNS name of the computer running Cassandra. For example change `rpc_address: localhost` to `rpc_address: 10.10.10.10`
6. Search for native_transport_port:
7. Verify that the setting is:
   native_transport_port: 9042 (or the port you are using)
8. Save and exit the file.
9. Restart the AccessData Cassandra service.
Migrating Legacy KFF Data from Previous Versions

You can migrate KFF Data from a previous KFF Server architecture to a newer one.

- See Migrating Legacy KFF Data from versions 5.6 - 6.2 to 6.4 on page 52.
- See Migrating Legacy KFF Data from versions 5.5 and earlier on page 53.

Migrating Legacy KFF Data from versions 5.6 - 6.2 to 6.4

If you have applications version 6.3 and later and you previously used KFF with applications versions 5.5 - 6.2, you can migrate the older data from the Elasticsearch KFF Server to the new KFF Server architecture used in 6.3 and later. To migrate the KFF data, you use the AccessData Has Manager Migration Tool. This tool is a separate Windows-based application.

Important: Please note the following:

- Applications version 6.3 and later can only use the new KFF architecture that was introduced in versions 6.3. If you want to use KFF data from previous versions, you must migrate the data.
- If you have NSRL, NDIC, or DHS data in your legacy data, those sets will not be migrated. You must re-import them using the 6.3 versions or later of those libraries. Only legacy custom KFF data will be migrated.
- You must use the same version of the KFF Migration as the product you are using. If you are using 6.4, you must use the 6.4 version of the KFF Migration Tool.
- You cannot migrate data from 5.5 and earlier directly to 6.3 or later. You must do a two-step migration process and migrate first to the 5.6-6.2 format.
- If you already have data in Cassandra and you migrate from Elasticsearch, if the same hash exists on bother servers, and one if either one of them has an Alert status, it will be given an Alert status. Otherwise, data will be migrated with the same values.

Legacy KFF data is migrated to KFF Groups and Hash Sets on the new KFF Server.

You migrate data using the KFF Migration Tool. To use the KFF Migration Tool, you identify the following:

- The server where the legacy Elasticsearch KFF data is located.
- The server where the legacy Elasticsearch KFF data will be located to (the Cassandra location).

To install the KFF Migration Tool

1. You can install the KFF Migration Tool onto any computer as long as it can access the servers running Elasticsearch and Cassandra.
2. Access the KFF Installation disc, and run the autorun.exe.
3. Click the Hash Manager Migration Tool.
4. Complete the installation wizard.
   The default path is Program Files (x86)\AccessData\HashManagerMigration. You can use the default or enter a new path.
5. The tool is automatically opened after installation.
To migrate legacy KFF data

1. Launch the KFF Hash Manager Migration Tool.
2. Enter the location and port of the legacy ElasticSearch KFF data.
   For example, if ElasticSearch is on the same computer, you can use the default location of http://localhost:9200.
   If it is on a different computer, enter the IP address and port of the computer. For example, http://10.10.10.10:9200.
3. Enter the location of the new KFF server (Cassandra database).
   For example, if Cassandra is on the same computer, you can use the default location of localhost. If it is on a different computer, enter the IP address, for example, 10.10.10.10.
4. Click Start Migration.

Migrating Legacy KFF Data from versions 5.5 and earlier

If you have used KFF with applications versions 5.5 and earlier, you can migrate that data from the legacy KFF Server to the Elasticsearch KFF Server architecture that was used in version 5.6 - 6.2. You cannot migrate data from 5.5 directly to 6.3 or later. Instead, you must upgrade the legacy to a 5.6 - 6.2 format, then migrate that to 6.3.

Important: Applications version 5.6 - 6.2 can only use the Elasticsearch KFF architecture. If you want to use KFF data from previous versions, you must migrate the data.

Important: If you have NSRL, NDIC, or DHS data in your legacy data, those sets will not be migrated. You must re-import them using the 5.6 - 6.2 versions of those libraries. Only legacy custom KFF data will be migrated.

Legacy KFF data is migrated to KFF Groups and Hash Sets on the new KFF Server.

Because KFF Templates are no longer used, they will be migrated as KFF Groups, and the groups that were under the template will be added as sub-groups.

You migrate data using the KFF Migration Tool. To use the KFF Migration Tool, you identify the following:

- The Storage Directory folder where the legacy KFF data is located.
  This was folder was configured using the KFF Server Configuration utility when you installed the legacy KFF Server. If needed, you can use this utility to view the KFF Storage Directory. The default location of the KFF_Config.exe file is Program Files\AccessData\KFF.
- The URL of the new KFF Server (the computer running the AccessData Elastic Search Windows Service)
  This is populated automatically if the new KFF Server has been installed.

To install the KFF Migration Tool

1. On the computer where you have installed the KFF Server, access the KFF Installation disc, and run the autorun.exe.
2. Click the 64 bit or 32 bit Install KFF Migration Utility.
3. Complete the installation wizard.

To migrate legacy KFF data

1. On the legacy KFF Server, you must stop the KFF Service.
   You can stop the service manually or use the legacy KFF Config.exe utility.
2. On the new KFF Server, launch the KFF Migration Tool.
3. Enter the directory of the legacy KFF data.
4. The URL of Elasticsearch should be listed.
5. Click **Start**.
6. When completed, review the summary data.
# Importing KFF Data

## About Importing KFF Data

You can import hashes and KFF Groups that have been previous configured.

You can import KFF data in one of the following formats:

### KFF Data sources that you can import

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-configured KFF libraries</td>
<td>You can import KFF data from the following pre-configured libraries</td>
</tr>
<tr>
<td></td>
<td>- NIST NSRL</td>
</tr>
<tr>
<td></td>
<td>- NDIC HashKeeper</td>
</tr>
<tr>
<td></td>
<td>- DHS</td>
</tr>
<tr>
<td></td>
<td>- Law enforcement users: Project VIC</td>
</tr>
<tr>
<td></td>
<td>To import large KFF libraries, use the KFF Import Utility.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">About KFF Data Import Tools</a> on page 56.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Importing Pre-defined KFF Data Libraries</a> on page 59.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">KFF Library Reference Information</a> on page 67.</td>
</tr>
<tr>
<td>Custom Hash Sets and KFF Groups</td>
<td>You can import custom hashes from CSV and other file types.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">About the CSV Format</a> on page 42.</td>
</tr>
<tr>
<td></td>
<td>You can import custom CSV files either through the application or the KFF Import Utility.</td>
</tr>
<tr>
<td></td>
<td>Other files types can be imported in FTK.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">About KFF Data Import Tools</a> on page 56.</td>
</tr>
</tbody>
</table>
### About KFF Data Import Tools

When you import KFF data, you can use one of two tools:

#### KFF Data Import Tools

<table>
<thead>
<tr>
<th>The application's Import feature</th>
<th>The KFF management feature in the application lets you import .CSV files (especially files that only have one KFF status). For FTK-based forensics products, you can also import custom hashes from the following file types:</th>
</tr>
</thead>
</table>
|                                 | - Delimited files (CSV or TSV)  
- Hash Database files (HDB)  
- Hashkeeper files (HKE)  
- FTK Exported KFF files (KFF)  
- FTK Supported XML files (XML)  
- FTK Exported Hash files (HASH)  
- Project VIC JSON files |
| To import these kinds of files, use the KFF Import feature in your application. See [Using the Known File Feature](#) chapter. You can also manually create your own KFF hash set data. |

<table>
<thead>
<tr>
<th>KFF Import Utility</th>
<th>You can import files using the KFF Import Utility. It is recommended that you use the KFF Import Utility to import files in the following situations:</th>
</tr>
</thead>
</table>
|                    | - A CSV file that has a mixture of Alert and Ignore statuses.  
- Large pre-configured libraries:  
  - NIST NSRL  
  - NDIC HashKeeper  
  - DHS |
| See [Using the KFF Import Utility](#) on page 57. |

**Important:** You must use the same version of the KFF Import Utility as the product you are using. If you are using 6.4, you must use the 6.4 version of the KFF Import Utility to import the NSRL library into the KFF Server.

### About Default Status Values

When you import KFF data, you configure a default status value of Alert or Ignore. When adding Hash Sets to KFF Groups, you can configure the KFF Groups to use the default status values of the Hash Set or you can configure the KFF Group with a status that will override the default Hash Set values.

See [Components of KFF Data](#) on page 39.

### About Duplicate Hashes

If multiple Hash Set files containing the same Hash identifier are imported into a single KFF Group, the group keeps the last Hash Set's metadata information, overwriting the previous Hash Sets’ metadata. This only happens within an individual group and not across multiple groups.
Using the KFF Import Utility

It is important that you use the correct version of the KFF Import Utility with the version of the application you are using. The KFF Import Utility was modified significantly for 6.3.

**Important:** You must use the same version of the KFF Import Utility as the product you are using.
- If you are using 6.4, you must use the 6.4 version of the KFF Import Utility to import the NSRL library into the KFF Server.
- If you are using 6.3, you must use the 6.3 version of the KFF Import Utility to import the NSRL library into the KFF Server.

**Using the KFF Import Utility versions 6.3 and later**

About the KFF Import Utility

Due to the large size of some KFF data, a stand-alone KFF Import utility is available to use to import the data. This KFF Import utility can import large amounts of data faster than using the import feature in the application. It is recommended that you install and use the KFF Import utility to import the following pre-configured libraries:
- NIST NSRL
- NDIC HashKeeper
- DHS

After importing NSRL, NDIC, or DHS libraries, these libraries are displayed in the *Currently Installed Sets* list.

See [Components of KFF Data](#) on page 39.

You can also use the KFF Import Utility to remove the NSRL, NDIC, or DHS indexes that you have imported.

Installing the KFF Import Utility versions 6.3, 6.4, and later

You must use the matching version of the KFF Import Utility with your application, for example, 6.3 or 6.4.

**To install the KFF Import Utility**

1. On the computer where you have installed the KFF Server, access the KFF installation disc, and run the autorun.exe.
2. Click the **Install KFF Import Utility**.
3. Complete the installation wizard.
4. To import libraries, see [About Importing Pre-defined KFF Data Libraries](#) on page 59.
Importing a CSV Using the KFF Import Utility versions 6.3 and later

You can import Hash Sets and KFF Groups by importing a custom CSV file.

See About the CSV Format on page 42.

To import a CSV using the KFF Import Utility
1. Open the KFF Import Utility.
2. Click the Browse .. button and locate the CSV that you want to import.
3. Click Open.
4. (Optional) - Enter package, vendor, version, etc.
5. If you installed Cassandra enabling Remote Access, in the Server address field, you must enter the computer's IP that has Cassandra installed on it, even if it is on the same computer as the import utility. Otherwise, leave it as localhost.
6. Click Import.
7. When complete, click OK.

Verifying a File Using the KFF Import Utility versions 6.3 and later

You can verify imported Hash Sets and KFF Groups to ensure the correct file is being imported.

To verify a file using the KFF Import Utility
1. Open the KFF Import Utility.
2. Click the Browse .. button and locate the file that you want to import.
3. (Optional) - Enter set name, package, vendor, version, and set status.
4. If you installed Cassandra enabling Remote Access, in the Server address field, you must enter the computer's IP that has Cassandra installed on it, even if it is on the same computer as the import utility. Otherwise, leave it as localhost.
5. Click Verify.
6. When complete, the Success window will appear, showing the following details:
   - Group Count
   - Set Count
   - Hash Count
   - Photo DNA Count
7. If you would like to open the log for further examination of the data, select Yes. If not, select No and the window will close.

Removing Pre-defined KFF Libraries Using the KFF Import Utility version 6.3 and later

You can remove a pre-defined KFF Library that you have previously imported.

You cannot see or remove existing custom KFF data (your own CSVs or manually entered data).

To remove pre-defined KFF Libraries
1. On the KFF Server, open the KFF Import Utility.
2. Select the library that you want to remove.
3. Click Remove.
Importing Pre-defined KFF Data Libraries

About Importing Pre-defined KFF Data Libraries

After you install the KFF Server, you can import pre-defined NIST NSRL, NDIC HashKeeper, and DHS data libraries.

See About KFF Pre-Defined Hash Libraries on page 67.

Important: In versions 6.3, you must import specific files for these versions. It is recommend that you use the KFF Import Utility.

After importing pre-defined KFF Libraries, you can remove them from the KFF Server.

- Removing Pre-defined KFF Libraries Using the KFF Import Utility version 6.3 and later (page 58)

See the following sections:

- Importing the NIST NSRL Library (page 60)
- Importing the NDIC Hashkeeper Library (page 64)
- Importing the DHS Library (page 64)
Importing the NIST NSRL Library

To import NSRL data in applications version 6.3, 6.4 and later, you can do one of the following:

- Download version 2.58 or later RDS files from nist.gov and import them. See Downloading and Importing the NIST NSRL Files from NIST.ORG on page 60.
- Download version 2.54 files from AccessData and import them. See Downloading and Importing the NIST NSRL Files from NIST.ORG on page 60.

Downloading and Importing the NIST NSRL Files from NIST.ORG

You can download the latest ISO files directly from the NIST.GOV. After you have downloaded the files, you import them into the KFF Server.

Before importing NSRL data, we recommend that you verify the hashes of the iso files that you downloaded from NIST. This assures that the data has not been corrupted.

Important: Please note the following:

- The complete NSRL library data is contained in a large (3 GB) .ZIP file in the image file. When expanded, the data is about 14 GB.
- You must not have a previous version version of the NSRL library installed. If needed, uninstall the previous version first.

To download NSRL files from NIST.ORG

2. Click NSRL Download.
3. Click Current RDS Hash Sets.
4. Click and download Modern RDS.
5. Compare and the hashes of your downloaded iso files with the hashes listed at: https://s3.amazonaws.com/rds.nsrl.nist.gov/RDS/current/version.txt
   (This address is case-sensitive)
To prepare NSRL files for importing

1. Mount the RDS ISO file.
2. Create a folder that you can browse to from the Import Utility (for example, RDS_258_modern).
3. Extract the NSRLFile.txt.zip file into that RDS folder.
4. Copy the following files from the ISO image to that same RDS folder:
   - NSRLProd.txt
   - NSRLOS.txt
   - NSRLMfg.txt
5. Create an AppTypes.txt file.
   In this file, you can specify application files that you may want to flag as Alert rather than Ignore.
   5a. In the same folder as the NSRLFile.txt.zip file, create a text file named AppTypes.txt.
   5b. In the file, include the following text:
      This is a text file listing the application types (one per line) which should have "Alert" status set:
      - Anti-KeyLogger
      - Computer Investigation
      - Data Encryption
      - Disk Wiper
      - Encryption
      - Forensic
      - Forensic Toolkit
      - Hacker Tool
      - Keyboard Logger
      - Steganography
   5c. Save and exit the file.
6. Verify that the folder has the following files:
   - NSRLProd.txt
   - NSRLOS.txt
   - NSRLMfg.txt
   - NSRLFile.txt
   - AppTypes.txt

To import the NIST NSRL library

1. On the KFF Server, launch the 6.3 or later version of the KFF Import Utility.
   See About Importing KFF Data on page 55.
2. Do the following:
   2a. In the File to Import field, browse to and select the NSRLFile.txt file that you previously extracted.
   2b. If you installed Cassandra enabling Remote Access, in the Server address field, you must enter the computer’s IP that has Cassandra installed on it, even if it is on the same computer as the import utility. Otherwise, use localhost.
   2c. Click Import.
   2d. When the import is complete, click OK.
   2e. The NSRL library will be listed in the Currently Installed Sets.
Importing the NIST NSRL Library Files from AccessData

You can download version 2.54 files from AccessData and import them.

See About NSRL Library Files Provided by AccessData on page 63.

Important: The NSRL library data is contained in a large (3.75 GB) .ZIP file. When expanded, the data is about 21.7 GB. Make sure that your file system can support files of this size.

To install the NSRL library

1. On the computer that you want to be the KFF Server, extract the nsrlsource_2.54.zip file that is at the root of the ISO.
2. On the computer that you want to be the KFF Server, install the AccessData Cassandra Service.
3. Install the KFF Import Utility version 6.3.
4. Use the KFF Import Utility to import the NSRL library by doing the following:
   4a. Launch the KFF Import Utility.
   4b. Browse to the NSRLFile.txt that is contained in the nsrlsource_2.54 folder.
   4c. Click Open.
   4d. Click Import.
   4e. When the import is complete, a finished window pops up, click OK.
### About NSRL Library Files Provided by AccessData

You can import the NSRL library into your KFF Server. During the import, two KFF Groups are created: NSRL_Alert and NSRL_Ignore. In FTK-based products, these two groups are automatically added to the Default KFF Group.

The NSRL libraries are updated from time to time. The NSRL import feature supports appending new data and updating existing data when importing a newer version. To import and maintain the NSRL data, you do the following:

#### Process for Importing and Maintaining the NIST NSRL Library

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Import the complete NSRL library. You must first install the most current complete NSRL library. You can later add updates to it. To access and import the complete NSRL library, see Importing the NIST NSRL Library (page 60)</td>
</tr>
<tr>
<td>2.</td>
<td>Import updates to the library When updates are made available, import the updates to bring the data up-to-date. See Installing KFF Updates on page 66. <strong>Important</strong>: In order to use the NSRL updates, you must first import the complete library. When you install an NSRL update, you must keep the previous NSRL versions installed in order to maintain the complete set of NSRL data.</td>
</tr>
</tbody>
</table>

#### Available NSRL library files (new format)

<table>
<thead>
<tr>
<th>NSRL Library Release</th>
<th>Released</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete library version 2.54 (source .ZIP file)</td>
<td>Mar 2017</td>
<td>For use only with applications version 5.6 and later. Contains the full NSRL library up through update 2.54.</td>
</tr>
<tr>
<td>Complete library version 2.45 (source .ZIP file)</td>
<td>Nov 2014</td>
<td>For use only with applications version 5.6 and later. Contains the full NSRL library up through update 2.45.</td>
</tr>
</tbody>
</table>
Importing the NDIC Hashkeeper Library

You can import the Hashkeeper 9.08 library.

For application versions 6.3 and later, these files are stored in CSV format.

To import the Hashkeeper library

1. Have access to the NDIC source files by download the ZIP file from the web:
   See Downloading the Latest KFF Installation Files on page 44.
2. Extract the ZIP file.
3. On the KFF Server, launch the 6.3 or later version of the KFF Import Utility.
   See About Importing KFF Data on page 55.
4. Do the following:
   4a. In the File to Import field, browse to and select the ndic.csv file.
   4b. If you installed Cassandra enabling Remote Access, in the Server address field, you must enter the computer’s IP that has Cassandra installed on it, even if it is on the same computer as the import utility. Otherwise, use localhost.
   4c. Click Import.
   4d. The import may take a few minutes.
   4e. When the import is complete, click OK.
   4f. The NDIC library will be listed in the Currently Installed Sets.

Importing the DHS Library

You can import the DHS 1.08 library.

For application versions 6.3 and later, these files are stored in CSV format.

To import the DHS library

1. Have access to the DHS source files by download the ZIP file from the web:
   See Downloading the Latest KFF Installation Files on page 44.
2. Extract the ZIP file.
3. On the KFF Server, launch the 6.3 or later version of the KFF Import Utility.
   See About Importing KFF Data on page 55.
4. Do the following:
   4a. In the File to Import field, browse to and select the dhs.csv file.
   4b. If you installed Cassandra enabling Remote Access, in the Server address field, you must enter the computer’s IP that has Cassandra installed on it, even if it is on the same computer as the import utility. Otherwise, use localhost.
   4c. Click Import.
   4d. The import may take a few minutes.
   4e. When the import is complete, click OK.
   4f. Do not process with NSRL data until there is confirmation that the import is done.
   4g. The DHS library will be listed in the Currently Installed Sets.
Uninstalling KFF

You can uninstall KFF application components independently of the KFF Data.

<table>
<thead>
<tr>
<th>Main version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications 5.6 to 6.2</td>
<td>For applications version 5.6 and later, you uninstall the following components:</td>
</tr>
<tr>
<td></td>
<td>• <strong>AccessData Elasticsearch Windows Service</strong> (KFF Server) v1.2.7 and later</td>
</tr>
<tr>
<td></td>
<td>Note: Elasticsearch is used by multiple features in various applications, use caution when uninstalling this service or the related data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>AccessData KFF Import Utility</strong> (v5.6 and later)</td>
</tr>
<tr>
<td></td>
<td>• <strong>AccessData KFF Migration Tool</strong> (v1.0 and later)</td>
</tr>
<tr>
<td></td>
<td>• <strong>AccessData Geo Location Data</strong> (v2014.10 and later)</td>
</tr>
<tr>
<td></td>
<td>Note: This component is not used by the KFF feature, but with the KFF Server for the geolocation visualization feature.</td>
</tr>
<tr>
<td></td>
<td>The location of the KFF data is configured when the <strong>AccessData Elasticsearch Windows Service</strong> was installed. By default, it is located at C:\Program Files\AccessData\Elasticsearch\Data.</td>
</tr>
<tr>
<td>Applications 5.5 and earlier</td>
<td>For applications version 5.5 and earlier, you can uninstall the following components:</td>
</tr>
<tr>
<td></td>
<td>• <strong>KFF Server</strong> (v1.2.7 and earlier)</td>
</tr>
<tr>
<td></td>
<td>Note: The KFF Server is also used by the geolocation visualization feature.</td>
</tr>
<tr>
<td></td>
<td>• <strong>AccessData Geo Location Data</strong> (1.0.1 and earlier)</td>
</tr>
<tr>
<td></td>
<td>Note: This component is not used by the KFF feature, but with the KFF Server for the geolocation visualization feature.</td>
</tr>
<tr>
<td></td>
<td>The location of the KFF data was configured when the <strong>KFF Server</strong> was installed. You can view the location of the data by running the <strong>KFF.Config.exe</strong> on the KFF Server.</td>
</tr>
<tr>
<td></td>
<td>If you are upgrading from 5.5 to 5.6, you can migrate your KFF data before uninstalling the KFF Server.</td>
</tr>
</tbody>
</table>
Installing KFF Updates

From time to time, AccessData will release updates to the KFF Server and the KFF data libraries. Some of the KFF data updates may require you to update the version of the KFF Server. To check for updates, do the following:

1. Go to the KFF product download page. See Downloading the Latest KFF Installation Files on page 44.
2. Check for updates.
   - See About KFF Server Versions on page 43.
   - See Importing the NIST NSRL Library on page 60.
3. If there are updates, download them.
4. Install or import the updates.
KFF Library Reference Information

About KFF Pre-Defined Hash Libraries

This section includes a description of pre-defined hash collections that can be added as AccessData KFF data. The following pre-defined libraries are currently available for KFF and come from federal government agencies:

- NIST NSRL (The default library installed with KFF)
- NDIC HashKeeper (An optional library that can be downloaded from the AccessData Downloads page)
- DHS (An optional library that can be downloaded from the AccessData Downloads page)

For law enforcement users, you can also use Project VIC libraries. See Using Project VIC on page 318.

Use the following information to help identify the origin of any hash set within the KFF

- The NSRL hash sets do not begin with “ZZN” or “ZN”. In addition, in the AD Lab KFF, all the NSRL hash set names are appended (post-fixed) with multi-digit numeric identifier. For example: “Password Manager & Form Filler 9722.”
- All HashKeeper Alert sets begin with “ZZ”, and all HashKeeper Ignore sets begin with “Z”. (There are a few exceptions. See below.) These prefixes are often followed by numeric characters (“ZZN” or “ZN” where N is any single digit, or group of digits, 0-9), and then the rest of the hash set name. Two examples of HashKeeper Alert sets are:
  - “ZZ00001 Suspected child porn”
  - “ZZ14W”
  - An example of a HashKeeper Ignore set is:
  - “Z00048 Corel Draw 6”
- The DHS collection is broken down as follows:
  - In 1.81.4 and later there are two sets named “DHS-ICE Child Exploitation JAN-1-08 CSV” and “DHS-ICE Child Exploitation JAN-1-08 HASH”.
  - In AD Lab there is just one such set, and it is named “DHS-ICE Child Exploitation JAN-1-08”.

Once an investigator has identified the vendor from which a hash set has come, he/she may need to consider the vendor’s philosophy on collecting and categorizing hash sets, and the methods used by the vendor to gather hash values into sets, in order to determine the relevance of Alert (and Ignore) hits to his/her project. The following descriptions may be useful in assessing hits.
NIST NSRL

The NIST NSRL collection is described at: [http://www.nsrl.nist.gov/index.html](http://www.nsrl.nist.gov/index.html). This collection is much larger than HashKeeper in terms of the number of sets and the total number of hashes. It is composed entirely of hash sets being generated from application software. So, all of its hash sets are given Ignore status by AccessData staff except for those whose names make them sound as though they could be used for illicit purposes.

The NSRL collection divides itself into many sub-collections of hash sets with similar names. In addition, many of these hash sets are “empty”, that is, they are not accompanied by any hash values. The size of the NSRL collection, combined with the similarity in set naming and the problem of empty sets, allows AccessData to modify (or selectively alter) NSRL’s own set names to remove ambiguity and redundancy.


NDIC HashKeeper

NDIC’s HashKeeper collection uses the Alert/Ignore designation. The Alert sets are hash values contributed by law enforcement agents working in various jurisdictions within the US - and a few that apparently come from Luxemburg. All of the Alert sets were contributed because they were believed by the contributor to be connected to child pornography. The Ignore sets within HashKeeper are computed from files belonging to application software.

During the creation of KFF, AccessData staff retains the Alert and Ignore designations given by the NDIC, with the following exceptions. AccessData labels the following sets Alert even though HashKeeper had assigned them as Ignore: “Z00045 PGP files”, “Z00046 Steganos”, “Z00065 Cyber Lock”, “Z00136 PGP Shareware”, “Z00186 Misc Steganography Programs”, “Z00188 Wiping Programs”. The names of these sets may suggest the intent to conceal data on the part of the suspect, and AccessData marks them Alert with the assumption that investigators would want to be “alerted” to the presence of data obfuscation or elimination software that had been installed by the suspect.

The following table lists actual HashKeeper Alert Set origins:

**A Sample of HashKeeper KFF Contributions**

<table>
<thead>
<tr>
<th>Hash</th>
<th>Contributor</th>
<th>Location</th>
<th>Contact Information</th>
<th>Case/Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZZ00001</td>
<td>Suspected child porn</td>
<td>Det. Mike McNown &amp; Randy Stone</td>
<td>Wichita PD</td>
<td></td>
</tr>
<tr>
<td>ZZ00002</td>
<td>Identified Child Porn</td>
<td>Det. Banks</td>
<td>Union County (NJ) Prosecutor's Office</td>
<td>(908) 527-4508</td>
</tr>
<tr>
<td>ZZ00003</td>
<td>Suspected child porn</td>
<td>Illinois State Police</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ00004</td>
<td>Identified Child Porn</td>
<td>SA Brad Kropp, AFOSI, Det 307</td>
<td></td>
<td>(609) 754-3354</td>
</tr>
</tbody>
</table>
### A Sample of HashKeeper KFF Contributions (Continued)

<table>
<thead>
<tr>
<th>Hash</th>
<th>Contributor</th>
<th>Location</th>
<th>Contact Information</th>
<th>Case/Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZZ000000</td>
<td>NDIC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ000005</td>
<td>Rene Moes, Luxembourg Police</td>
<td><a href="mailto:rene.moes@police.eta">rene.moes@police.eta</a>@t.lu</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ000006</td>
<td>Illinois State Police</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ000007b</td>
<td>Suspected KP (US Federal)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ000007a</td>
<td>Suspected KP Movies</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ000007c</td>
<td>Suspected KP (Alabama 13A-12-192)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ000008</td>
<td>Sergeant Purcell</td>
<td>Seminole County Sheriff's Office (Orlando, FL, USA)</td>
<td>(407) 665-6948, <a href="mailto:dpurcell@seminolesheriff.org">dpurcell@seminolesheriff.org</a></td>
<td>suspected child pornography from 20010000850</td>
</tr>
<tr>
<td>ZZ000009</td>
<td>Sergeant Purcell</td>
<td>Seminole County Sheriff's Office (Orlando, FL, USA)</td>
<td>(407) 665-6948, <a href="mailto:dpurcell@seminolesheriff.org">dpurcell@seminolesheriff.org</a></td>
<td>200100004750</td>
</tr>
<tr>
<td>ZZ10</td>
<td>Detective Richard Voce CFCE</td>
<td>Tacoma Police Department</td>
<td>(253)594-7906, <a href="mailto:rvoce@ci.tacoma.wa.us">rvoce@ci.tacoma.wa.us</a></td>
<td></td>
</tr>
<tr>
<td>ZZ000011</td>
<td>Detective Michael Forsyth</td>
<td>Baltimore County Police Department</td>
<td>(410)887-1866, <a href="mailto:mick410@hotmail.com">mick410@hotmail.com</a></td>
<td></td>
</tr>
<tr>
<td>ZZ000012</td>
<td>Sergeant Purcell</td>
<td>Seminole County Sheriff's Office (Orlando, FL, USA)</td>
<td>(407) 665-6948, <a href="mailto:dpurcell@seminolesheriff.org">dpurcell@seminolesheriff.org</a></td>
<td></td>
</tr>
<tr>
<td>ZZ00013</td>
<td>Det. J. Hohl</td>
<td>Yuma Police Department</td>
<td>928-373-4694</td>
<td>YPD02-70707</td>
</tr>
<tr>
<td>Hash</td>
<td>Contributor</td>
<td>Location</td>
<td>Contact Information</td>
<td>Case/Source</td>
</tr>
<tr>
<td>-------</td>
<td>------------------</td>
<td>---------------------------</td>
<td>------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>ZZ14W</td>
<td>Sgt Stephen May</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 41929134</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14U</td>
<td>Sgt Chris Walling</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 41919887</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14X</td>
<td>Sgt Jeff Eckert</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG Internal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14I</td>
<td>Sgt Stephen May</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 041908476</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14B</td>
<td>Robert Britt, SA,</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 031870678</td>
</tr>
<tr>
<td></td>
<td>FBI</td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14S</td>
<td>Sgt Stephen May</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 041962689</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14Q</td>
<td>Sgt Cody Smirl</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 041952839</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ14V</td>
<td>Sgt Karen McKay</td>
<td>Tamara.Chandler@oa</td>
<td>(512)936-2898</td>
<td>TXOAG 41924143</td>
</tr>
<tr>
<td></td>
<td></td>
<td>g.state.tx.us</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ZZ00015</td>
<td>Known CP Images</td>
<td>Det. J. Hohl</td>
<td>Yuma Police</td>
<td>YPD04-38144</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Department</td>
<td></td>
</tr>
<tr>
<td>ZZ00016</td>
<td>Marion County</td>
<td>Marion County</td>
<td>(317) 231-8506</td>
<td>MP04-0216808</td>
</tr>
<tr>
<td></td>
<td>Sheriff's</td>
<td>Sheriff's</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Department</td>
<td>Department</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The basic rule is to always consider the source when using KFF in your investigations. You should consider the origin of the hash set to which the hit belongs. In addition, you should consider the underlying nature of hash values in order to evaluate a hit’s authenticity.
Higher Level KFF Structure and Usage

Since hash set groups have the properties just described (and because custom hash sets and groups can be defined by the investigator) the KFF mechanism can be leveraged in creative ways. For example:

- You could define a group of hash sets created from encryption software and another group of hash sets created from child pornography files. Then, you would apply only those groups while processing.
- You could also use the Ignore status. You are about to process a hard drive image, but your search warrant does not allow inspection of certain files within the image that have been previously identified. You could do the following and still observe the warrant:
  4a. Open the image in Imager, navigate to each of the prohibited files, and cause an MD5 hash value to be computed for each.
  4b. Import these hash values into custom hash sets (one or more), add those sets to a custom group, and give the group Ignore status.
  4c. Process the image with the MD5 and KFF options, and with AD_Alert, AD_Ignore, and the new, custom group selected.
  4d. During post-processing analysis, filter file lists to eliminate rows representing files with Ignore status.

Hash Set Categories

The highest level of the KFF’s logical structure is the categorizing of hash sets by owner and scope. The categories are AccessData, Project Specific, and Shared.

Hash Set Categories

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AccessData</td>
<td>The sets shipped with as the Library. Custom groups can be created from these sets, but the sets and their status values are read only.</td>
</tr>
<tr>
<td>Project Specific</td>
<td>Sets and groups created by the investigator to be applied only within an individual project.</td>
</tr>
<tr>
<td>Shared</td>
<td>Sets and groups created by the investigator for use within multiple projects all stored in the same database, and within the same application schema.</td>
</tr>
</tbody>
</table>

**Important:** Coordination among other investigators is essential when altering Shared groups in a lab deployment. Each investigator must consider how other investigators will be affected when Shared groups are modified.
What has Changed in Version 6.3

With the 6.3 release of eDiscovery, Summation, and FTK-based forensics products, the KFF architecture and features have been updated. This architecture is used in versions 6.3 and later.

If you used KFF with applications version 6.2 or earlier, be aware of the following changes in the KFF functionality.

**KFF Changes from version 6.2 to 6.3**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| **KFF Server** | KFF Server now runs as a different service.  
- In versions 5.6 through 6.2, the KFF Server ran as the *AccessData Elasticsearch Windows Service*.  
- In 6.3 and later, the KFF Server uses the *AccessData Cassandra* service.  
  **Important**: If you are upgrading from 6.2 or earlier, all KFF data must be created in or migrated into the new KFF Server.  
  See *Migrating Legacy KFF Data from versions 5.6 - 6.2 to 6.4* on page 52. |
| eDiscovery or Summation KFF Server Configuration Files | In eDiscovery or Summation, there are two configuration files that configure the location of the KFF server.  
See *Configuring the KFF Server Location on Summation or eDiscovery* on page 50.  
The location format and port value in those files have changed.  
In 5.6 - 6.2, the following was used:  
```xml  
<add key=”KffElasticSearchUrl” value=”http://localhost:9200” />  
```
In 6.3 it was changed to:
```xml  
<add key=”KFFServerUrl” value=”localhost:9042” />  
```
  **Note**: The “http://” text is no longer used and Cassandra uses port 9042 instead of 9200.  
  There is also a new line:
```xml  
<add key=”KFFServerDBType” value=”Cassandra” />  
```

| Hash Manager Migration Tool | If you are upgrading from 5.6 through 6.2, there is a new tool that lets you migrate custom KFF data to the new KFF Server on 6.3.  
See *Migrating Legacy KFF Data from versions 5.6 - 6.2 to 6.4* on page 52.  
**Important**: NIST NSRL, NDIC HashKeeper, or DHS library data from 6.2 and earlier will not be migrated when using the Migration Tool. You must re-import those using the 6.3 KFF Import Tool.  
See *About Importing Pre-defined KFF Data Libraries* on page 59. |
| KFF Import Utility | This utility has been updated to use the new KFF Server.  
If you are upgrading from 5.6 - 6.2, make sure to install and use the new 6.3 version.  
See *Using the KFF Import Utility* on page 57. |
# KFF Changes from version 6.2 to 6.3

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NDIC HashKeeper and DHS libraries</td>
<td>To use these libraries, you must import new versions of the files using the 6.3 version of the KFF Import Utility. NDIC HashKeeper and DHS libraries are now downloaded from AccessData and imported as CSV files. See About Importing Pre-defined KFF Data Libraries on page 59.</td>
</tr>
</tbody>
</table>
| NIST NSRL                | To import NSRL data, you can do either of the following:  
  - Download version 2.54 files from AccessData and import them.  
  - Download version 2.58 or later RDS files from nist.gov and import them.  
  See Importing the NIST NSRL Library on page 60. |
| Export/Import            | When you export and import KFF data, the Binary format (Entire Library) is no longer available. CSV is the only export format supported. |
| Geolocation data         | Geolocation data is installed independently and is no longer linked to KFF.                                                               |
What has Changed in Version 6.4

See the 6.4 Release Notes for the product you are using.
Chapter 6
Installing the AccessData Elasticsearch Windows Service

About the Elasticsearch Service

The AccessData Elasticsearch Windows Service is used by multiple features in multiple applications, including the following:

- KFF (Known File Filter) in all applications (versions 5.6 - 6.2)
- Visualization Geolocation in all applications (versions 5.6 - 6.2)

The AccessData Elasticsearch Windows Service uses the Elasticsearch open source search engine.

Prerequisites

- For best results with eDiscovery products and AD Lab and Enterprise, you should install the AccessData Elasticsearch Windows Service on a dedicated computer that is different from the computer running the application that uses it.
  For single-computer installations such as FTK, you can install the AccessData Elasticsearch Windows Service on the same computer as the application.
  A single instance of an AccessData Elasticsearch Windows Service is usually sufficient to support multiple features. However, if your network is extensive, you may want to install the service on multiple computers on the network. Consult with support for the best configuration for your organization’s network.
- You can install the AccessData Elasticsearch Windows Service on 32-bit or 64-bit computers.
- 16 GB of RAM or higher
- Microsoft .NET Framework 4
  To install the AccessData Elasticsearch Windows Service, Microsoft .NET Framework 4 is required. If you do not have .NET installed, it will be installed automatically.
- If you install the AccessData Elasticsearch Windows Service on a system that has not previously had an AccessData product installed upon it, you must add a registry key to the system in order for the service to install correctly.
Installing the Elasticsearch Service

Installing the Service

To install the AccessData Elasticsearch Windows Service

1. Click the AccessData Elasticsearch Windows Service installer. It is available on the KFF Installation disc by clicking autorun.exe.
2. On the welcome page, click Next.
3. Accept the License Agreement and click Next.
4. If you do not have Java installed, a message is displayed stating that you must install Java and the installation will end. See Prerequisites on page 75.
5. If you have upgraded your Java, you will get a Path Mismatch dialog. This asks you if you want to change the path of the JAVA_HOME variable to you new Java version. Click Yes.
6. On the Destination Folder dialog, click Next to install to the folder, or click Change to install to a different folder.
   This is where the Elasticsearch folder with the Elasticsearch service is installed.
7. On the Data Folder dialog, click Next to install to the folder, or click Change to install to a different folder.
   This is where the Elasticsearch data is stored.

   Note: This folder may contain up to 10GB of data.

   (For use with KFF) In the User Credentials dialog, you can configure credentials that the Elasticsearch service uses to access network shares. This is used when either importing KFF Data files, or when exporting KFF binary files.
   You have two options:
   - Local System Account - This option uses the Local System account. If you select this account, you can import files from and export files to a share that is accessible only to this local account. For example, with this option selected, you could export a binary only to a local share that this account can access. If you select the Local System Account, do not enter any domain value, such as localhost. Leave it blank instead.
   - Specified User Account - This option lets you specify a specific domain user account. If you select this account, you can import files from and export files to a network share that is available to the user. For example, with this option, you could export a binary to a share on a different computer. To use this option, enter the user name, the domain name, and the password.
   After installation, you can view and modify this setting by doing the following:
   - Open the Services window. The services window shows you the account that the service is logged in as. If the window doesn't show the column, you can add the column to the window.
   - You can right-click the service and select properties to have the option to change the account that the service has logged in as. The service has to be stopped first, and the restarted, in order to make a change.

9. In the Allow Remote Communication dialog, you can scale Elasticsearch by adding more machines. (Optional) Select Enable Remote Communication.

   Note: If Enable Remote Communication is selected, a firewall rule will be created to allow communication to the AccessData Elasticsearch Windows Service service for every IP address
added to the IP Address field. If no IP addresses are listed, then ANY IP address will be able to access the AccessData Elasticsearch Windows Service.

Either leave blank or add machines and click **Next**.

10. Configure ports for Elasticsearch to use and click **Next**.
   - HTTP Port
   - Transport Port

You can use the default ports or specify your own.

Using the defaults, whenever you click **Next**, the system will determine if the ports are available. If one is in use, a new value will automatically be entered. Click **Next** again to verify the ports and continue.

11. The **Configuration 1** dialog contains the following fields:
   - **Cluster name** - This field automatically populates with the system’s name.
   - **Node name** - This field automatically populates with the system’s name.

   **Note:** If installing the AccessData Elasticsearch Windows Service on more than one system, allow the first system to install with the system’s name in the cluster and the node fields. In the second and subsequent systems, enter the first system’s name in the cluster field, and in the node field, enter the name of the system to which you are installing.

   - **Heap size** - This is the memory allocated for the AccessData Elasticsearch Windows Service. Normally you can accept the default value. For improved performance of the AccessData Elasticsearch Windows Service, increase the heap size.

12. The **Configuration 2** dialog contains the following options:
   - **Discovery** - Selecting the default of **Multicast** allows the AccessData Elasticsearch Windows Service search to communicate across the network to other Elasticsearch services. If the network does not give permissions for the service to communicate this way, select **Unicast** and enter the IP address(es) of the server(s) that the AccessData Elasticsearch Windows Service is installed on in the **Unicast** host names field. Separate multiple addresses with commas.
   - **Node** - The Master node receives requests, and can pass requests to subsequent data nodes. Select both Master node and Data node if this is the primary system on which the AccessData Elasticsearch Windows Service is installed. Select only Data node if this is a secondary system on which the AccessData Elasticsearch Windows Service is installed. Click **Next**.

13. In the next dialog, click **Install**.

14. If the service installs properly, a command line window appears briefly, stating that the service has installed properly.

15. At the next dialog, click **Finish**.

**Troubleshooting the AccessData Elasticsearch Windows Service**

Once installed, the AccessData Elasticsearch Windows Service service should run without further assistance. If there are issues, go to `C:\Program Files\Elasticsearch\logs` to examine the logs for errors.
Chapter 7
Configuring and Managing Databases for FTK

This section provides information that you need to know to configure and manage the database for use with FTK.

For more information, see your SQL Server documentation or contact Technical Support.

This chapter contains the following sections:

- Best Practices for Using Oracle (page 78)
- Best Practices for using Microsoft SQL Server (page 80)

Best Practices for Using Oracle

If you are using Oracle 10g, you should consider installing Oracle Critical Patch Updates. You can download the Oracle Critical Patch Update 38 and 45 (April 2011) from the AccessData Support Downloads web page:

http://www.accessdata.com/support/product-downloads > Utilities

Important: Oracle 10g is not compatible with Windows 8.

For newer updates of Oracle 10, you must have an Oracle support contract. You can upload updates from the Oracle web site (http://www.oracle.com/technetwork/topics/security/alerts-086861.html).

To install an Oracle Critical Patch Update, first back up the database, and then close all programs before you install the patch. (58583, 58248)

If you do not have an Oracle support contract, consider changing from an Oracle database to PostgreSQL, which is available at no cost on the FTK Download page. You can easily migrate your cases from Oracle to PostgreSQL. For more information, contact your Technical Account Manager (TAM) at AccessData.

Oracle must be installed on a computer with a name that begins with a letter (a-z and A-Z). Due to a restriction on domain names in RFC 1035, applications cannot connect to Oracle if the computer’s name begins with a number. If the Oracle computer name begins with a number, you must change the machine name before installing Oracle.
**Optimize the Oracle Database**

AccessData Oradjuster.exe optimizes Oracle’s memory usage on your computer. This utility is particularly useful for 64-bit systems with large amounts of RAM installed. The Oradjuster utility is included on the FTK Application install disc. It can also be downloaded from the AccessData website, [www.accessdata.com/downloads](http://www.accessdata.com/downloads). Look under Utilities.

For more information about Oradjuster, including its installation, configuration, and use, see “Appendix G AccessData Oradjuster” of the FTK User Guide.

Choose **Optimize the Database** to run Oradjuster for the first time. During installation is the ideal time to run it because you will not have any processes running that will delay the optimization. Respond to the prompts as they appear.

**Patch the Database**

Choose to apply patches to the Oracle 10g database in preparation for the FTK schema to be laid down when you run FTK for the first time after all components are installed.

**Note:** Installing the patch can take as long as the original Oracle installation.
Best Practices for using Microsoft SQL Server

Configuring Microsoft SQL Server

If you are installing Microsoft SQL Server, perform the following configuration steps:

Configure SQL options during the SQL Installation
1. From the Setup Role page, choose SQL Server Feature Installation.
2. From the Feature Selection page, select the following features:
   - Database Engine Services
   - Full-Text Search
   - Management Tools- Basic
   - Management Tools - Complete
3. On the Instance Configuration page you can choose either Default instance or Named instance.
   If this SQL database is used exclusively by FTK, it is much simpler to choose default instance. If you
   choose named instance, remember the name that you give to the instance.)
4. On the Server Configuration page, do the following:
   4a. Click Use the same account for all SQL Server services.
   4b. Specify a username and password for all service accounts.
5. On the Database Engine Configuration page, choose the Mixed Mode authentication mode.

Configure SQL with the following collation
   "SQL_Latin1_General_CP1_CI_AS"

Enable TCP/IP for SQL Server
1. Open the SQL Server Configuration Manager.
   (Start > All Programs > Microsoft SQL Server > Configuration Tools > SQL Server Configuration Manager)
2. Expand SQL Server Network Configuration.
3. Select the SQL Instance to check or change.
4. Right-click Protocol Name TCP/IP and click Enable.
5. Stop and Start the SQL Service.

Configure Microsoft SQL Server authentication mode, remote connections, and default storage location settings
1. Open the SQL Server Management Studio (SSMS).
   (Start > All Programs > Microsoft SQL Server > Configuration Tools > SQL Server Configuration Manager.)
2. Enter the correct server name or servername/instance, authentication (Windows Authentication, SQL Authentication), and credentials.
3. Once connected to the SQL Server, in the Object Explorer Pane, right-click Properties of the server/ instance that you want to configure.
4. To check or change the SQL authentication mode, do the following:
   4a. Click the Security tab.
5. (Optional) To enable remote connections to the server, do the following:
   5a. Click the **Connections** tab.
   5b. Under **Remote Server Connections**, check **Allow remote connections to this server** is enabled.
6. To make changes to the database default storage locations, do the following:
   6a. Click the **Database Settings** tab.
   6b. Under **Database default locations**, change the **Data** and **Log** locations as desired.
7. Click **OK**.
8. Stop and restart the SQL service.

**Maintaining and Optimizing Microsoft SQL Server**

After you install FTK and initialize the database, you can do the following to manage and optimize SQL.

Upon installation, dbowner rights need to be added to ediscovery, infrastructure, workflow, and workflow40 databases for a non-sysadmin services user. However, there is no need to add dbowner rights to the adg database. (18505)

If you are using a single computer installation, where the SQL database and other applications are installed together, it will improve your performance to limit the amount of memory that SQL can use. The default SQL setting is to use all the memory that it can, which can cause performance issues. If the SQL database is on a dedicated computer, this is not an issue

**Configuring Case User Databases: Initial Size and Autogrowth**

Case databases should be set to an estimated size based on the initial size of the data that will be ingested into it after the case is created. This can be found under the **Database Properties** > **Files** tab.

AccessData applications use files and filegroups. The files and data stored is within the following:

File (ex ADG53_####_TSf) in Filegroup (ex ADG53_####_TS)

This is what should be considered for changes to initial size and autogrowth settings.

A very rough rule is that the database will grow to 1/3 of the ingested data. This is not an exact estimate as multiple factors have to be taken into account regarding the data. Depending on the size and work being done in the case, Autogrowth should be considered as a percent or static size. Autogrowth for the case file can be initially set to 100 MB and 50 MB for the log file for the case database. These values should be monitored and changed as appropriate.

The database requiring growth during operation can hamper performance due to the server and disk activity required to grow the database as it becomes full.

**To configure datafile and transaction log file settings**

1. Open the SQL Server Management Studio (SSMS).
   (Start > All Programs > Microsoft SQL Server > Configuration Tools > SQL Management Studio.)
2. Enter the correct server name or servername/instance, authentication (Windows Authentication, SQL Authentication), and credentials.
3. Once connected to the SQL Server, in the *Object Explorer Pane*, right-click **Properties** on the FTK database.
   The default database name that FTK created is ADG. If you used a different name, select that database.

4. Click **Files**.

5. Under **Database** files, do the following:
   5a. For the datafile (first row), set the autogrowth setting from 1 MB to 100 MB.
   5b. For the transaction log file (second row), set the autogrowth setting from 10% to 50 MB.

6. Repeat for all FTK databases.

7. Click **OK**.

8. Stop and restart the SQL service.

**MS SQL Memory Allocation**

A general rule for memory allocation to the Windows OS is that for first 16 GB of Memory the operating system is allocated 4 GB. Afterwards for every additional 4 GB of memory the system gets 1 GB. SQL by default will take as much memory as possible. For Windows servers running only Microsoft SQL Server the following rule should be adhered to for Maximum memory allocated to the application subtracted by what will be required by the OS. Systems sharing memory with application other than MSSQL a maximum memory should be set as to not take away all available memory for the other applications.

**MS SQL Temp DB**

SQL and the application use the tempdb database for storage of various temporary tables. Improved performance can be found with setting an increased size for the MDF file as well as having additional tempdb files allocated to the database.

We recommend increasing the initial tempdb mdf file to 2 GB and Log file to 1 GB. We also recommend adding additional tempdb mdf files, at least 2 db in size, for every physical core (up to a maximum of 8 total files).

**Maintenance Jobs**

You can create maintenance jobs to perform defragmentation and rebuilding of indexes, integrity and consistency checks, DBCC checkdb, backups, blocking sessions and database file monitor.

Maintenance jobs for backup, defragmentation and rebuild of indexes are default maintenance tasks that can be created via SSMS.

A rough estimate of a defragmentation job would be every day with a rebuild once a week. Actual expected rules are indexes with pages > 100 and fragmentation over 60 become rebuild and anything below to be re-org.

Maintenance jobs for Backups Full, Differential, Transaction should be based on your environment. These maintenance tasks can hamper performance as they can run into production hours depending on size of the database.
Other SQL Best Practices

Additional improvements can be made by setting the SQL Recovery Model to “Simple”. This can result in less writes, providing less I/O to disk, and storage to the Log file (LDF). However, this can put you at risk as this disallows transaction backups and Tail Log restores.

DBCC, database file monitoring, and blocking sessions are advanced SQL items used to troubleshoot and resolve issues that may be occurring. These are least likely to be needed for your system’s day-to-day operation.
Chapter 8
Managing Security Devices and Licenses

This appendix includes information AccessData product licenses, Virtual CodeMeter activation, and Network License Server configurations.

Installing and Managing Security Devices

AccessData products require a licensing security device that communicates with the program to verify the existence of a current license.

You must install the security device software and drivers before you can manage licenses with LicenseManager. This section explains installing and using the CodeMeter Runtime software and the License Manager.

Installing the Security Device

AccessData products require a licensing security device that communicates with the program to verify the existence of a current license. The device is a WIBU-SYSTEMS (Wibu) CodeMeter (CmStick). This USB device requires specific software to be installed prior to connecting the devices and running your AccessData products. You will need the WIBU-SYSTEMS CodeMeter Runtime software with a WIBU-SYSTEMS CodeMeter (CmStick), either the physical USB device, or the Virtual device.

Store the CmStick or dongle in a secure location when it is not in use.

Installing the CodeMeter Runtime Software

When you purchase a product, AccessData provides a USB CmStick with the product package. To use the CmStick, you must first install the CodeMeter Runtime software, either from the shipping disc or from the setup file downloaded from the AccessData Web site.

Note: The CodeMeter software is automatically installed as part of the FTK suite.

To download the CodeMeter installer from the AccessData web site

2. On the download page, click CodeMeter.
3. Click Download Page.
4. Click **Download Now**.
5. Save the installation file to your download directory or other temporary directory on your drive.

**To install CodeMeter**

1. Do one of the following:
   - Launch the installer from the FTK installer by doing the following:
     1a. Launch the FTK installer *Autorun.exe* file.
     1b. Click **Other Products**.
     1c. Click Install License Manager.
   - Launch the installer from the download by doing the following:
     1a. Navigate to, and double-click the installation file.
2. Wait for the **Preparing to Install** processes to complete.
3. In the Welcome dialog, click **Next**.
4. Read and accept the License Agreement
5. Enter User Information.
6. Click **Next**.
7. Select the features you want to install.
8. Click **Next**.
9. Click **Install**.
10. Click **Finish**.
11. Click **OK**.

**CodeMeter Error**

If you are not using NLS for your security device configuration, after clicking **No**, you will see the following additional message.

*Security Device Not Found*

To remedy, click **OK**, then install the correct CodeMeter Runtime software, and connect the CmStick or run License Manager to generate your Virtual CmStick. Then, restart FTK.
Installing LicenseManager

LicenseManager lets you manage product and license subscriptions using a security device or device packet file.

You can access the LicenseManager installer from the Web or from the FTK installer.

To download the LicenseManager installer from the AccessData web site

2. On the download page, click LicenseManager.
3. Click Download Page.
4. Click Download Now.
5. Save the installation file to your download directory or other temporary directory on your drive.

To install LicenseManager

1. Do one of the following:
   - Launch the installer from the FTK installer by doing the following:
     1a. Launch the FTK installer Autorun.exe file.
     1b. Click Other Products.
     1c. Click Install License Manager.
   - Launch the installer from the download by doing the following:
     1a. Navigate to, and double-click the installation file.
2. Wait for the Preparing to Install processes to complete.
3. Click Next on the Welcome screen
4. Read and accept the License Agreement.
5. Click Next.
6. Accept the default destination folder, or select a different one.
7. Click Next.
8. In the Ready to Install the Program dialog, click Back to review or change any of the installation settings. When you are ready to continue, click Install.
9. Wait while the installation completes.
10. If you want to launch LicenseManager after completing the installation, mark the Launch AccessData LicenseManager check box.
11. Select the Launch AccessData LicenseManager check box to run the program upon finishing the setup. The next section describes how to run LicenseManager later.
12. Click Finish to finalize the installation and close the wizard.
Starting LicenseManager

To launch LicenseManager

1. Launch LicenseManager by clicking the LicenseManager icon on your desktop. When starting, LicenseManager reads licensing and subscription information from the installed and connected WIBU-SYSTEMS CodeMeter Stick, or Keylok dongle.

   **Note:** If using a Keylok dongle, and LicenseManager either does not open or displays the message, “Device Not Found”

2. Verify the correct dongle driver is installed on your computer.
3. With the dongle connected, check in Windows Device Manager to make sure the device is recognized. If it has an error indicator, right click on the device and choose Uninstall.
4. Remove the dongle after the device has been uninstalled.
5. Reboot your computer.
6. After the reboot is complete, and all startup processes have finished running, connect the dongle.
7. Wait for Windows to run the Add New Hardware wizard. If you already have the right dongle drivers installed, do not browse the internet, choose, “No, not this time.”
8. Click **Next** to continue.
9. On the next options screen, choose, “Install the software automatically (Recommended)”, then click **Next** to continue.
10. When the installation of the dongle device is complete, click **Finish** to close the wizard.
11. You still need the CodeMeter software installed, but will not need a CodeMeter Stick to run LicenseManager.

   **Note:** If using a CodeMeter Stick, and LicenseManager either does not open or displays the message, “Device Not Found”

12. Make sure the CodeMeter Runtime 4.20b software is installed. It is available at [www.accessdata.com/support](http://www.accessdata.com/support). Click Downloads and browse to the product. Click on the download link. You can **Run** the product from the Website, or **Save** the file locally and run it from your PC. Once the CodeMeter Runtime software is installed and running, you will see a gray icon in your system tray.
13. Make sure the CodeMeter Stick is connected to the USB port.

   If the CodeMeter Stick is not connected, LicenseManager still lets you to manage licenses using a security device packet file if you have exported and saved the file previously.

To open LicenseManager without a CodeMeter Stick installed

1. Click **Tools > LicenseManager**. LicenseManager displays the message, “Device not Found”.
2. Click **OK**, then browse for a security device packet file to open.

   **Note:** Although you can run LicenseManager using a packet file, AccessData products will not run with a packet file alone. You must have the CmStick or dongle connected to the computer to run AccessData products that require a license.
Using LicenseManager

LicenseManager provides the tools necessary for managing AccessData product licenses on a WIBU-SYSTEMS CodeMeter Stick security device, a Keylok dongle, a Virtual Dongle, or in a security device packet file.

LicenseManager displays license information, allows you to add licenses to or remove existing licenses from a dongle or CmStick. LicenseManager, and can also be used to export a security device packet file. Packet files can be saved and reloaded into LicenseManager, or sent via email to AccessData support.

In addition, you can use LicenseManager to check for product updates and in some cases download the latest product versions.

LicenseManager displays CodeMeter Stick information (including packet version and serial number) and licensing information for all AccessData products. The Purchase Licenses button connects directly to the AccessData website and allows you to browse the site for information about products you may wish to purchase. Contact AccessData by phone to speak with a Sales Representative for answers to product questions, and to purchase products and renew licenses and subscriptions.

The LicenseManager Interface

The LicenseManager interface consists of two tabs that organize the options in the LicenseManager window: the Installed Components tab and the Licenses tab.

The Installed Components Tab

The Installed Components tab lists the AccessData programs installed on the machine. The Installed Components tab is displayed in the following figure.

The following information is displayed on the Installed Components tab:

LicenseManager Installed Components Tab Features

<table>
<thead>
<tr>
<th>Program</th>
<th>Displays the version of each AccessData product installed on the host.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed Version</td>
<td>Displays the latest version available of each AccessData product installed on the host. Click Newest to refresh this list.</td>
</tr>
<tr>
<td>Newest Version</td>
<td>Displays notes and information about the product selected in the program list.</td>
</tr>
<tr>
<td>Product Notes</td>
<td>Links to the AccessData product page where you can learn more about AccessData products.</td>
</tr>
</tbody>
</table>

The following buttons provide additional functionality from the Installed Components tab:

LicenseManager Installed Components Buttons

| Help       | Opens the LicenseManager Help web page. |
Use the Installed Components tab to manage your AccessData products and stay up to date on new releases.

The Licenses Tab

The Licenses tab displays CodeMeter Stick information for the current security device packet file and licensing information for AccessData products available to the owner of the CodeMeter Stick, as displayed in the following figure.

The Licenses tab provides the following information:

**LicenseManager Licenses Tab Features**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Shows the owned licenses for AccessData products.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Shows the date on which your current license expires.</td>
</tr>
<tr>
<td>Status</td>
<td>Shows these status of that product’s license:</td>
</tr>
<tr>
<td></td>
<td>- <strong>None</strong>: the product license is not currently owned</td>
</tr>
<tr>
<td></td>
<td>- <strong>Days Left</strong>: displays when less than 31 days remain on the license.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: the license is permanently owned. This generally applies to</td>
</tr>
<tr>
<td></td>
<td>Hash Tables and Portable Office Rainbow Tables.</td>
</tr>
<tr>
<td>Name</td>
<td>Shows the name of additional parameters or information a product requires</td>
</tr>
<tr>
<td></td>
<td>for its license.</td>
</tr>
<tr>
<td>Value</td>
<td>Shows the values of additional parameters or information a product contained</td>
</tr>
<tr>
<td></td>
<td>in or required for its license.</td>
</tr>
<tr>
<td>Show Unlicensed</td>
<td>When checked, the License window displays all products, whether licensed or</td>
</tr>
<tr>
<td></td>
<td>not.</td>
</tr>
</tbody>
</table>

The following license management actions can be performed using buttons found on the License tab:

**License Management Options**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Newest</td>
<td>Installs the newest version of the programs checked in the product window, if that program is</td>
</tr>
<tr>
<td></td>
<td>available for download. You can also get the latest versions from our website using your Internet</td>
</tr>
<tr>
<td></td>
<td>browser.</td>
</tr>
<tr>
<td>Newest</td>
<td>Updates the latest version information for your installed products.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the About LicenseManager screen. Provides version, copyright, and trademark information</td>
</tr>
<tr>
<td></td>
<td>for LicenseManager.</td>
</tr>
<tr>
<td>Done</td>
<td>Closes LicenseManager.</td>
</tr>
<tr>
<td>Remove License</td>
<td>Removes a selected license from the Licenses window and from the CodeMeter Stick or dongle.</td>
</tr>
<tr>
<td></td>
<td>Opens the AccessData License Server web page to confirm success.</td>
</tr>
<tr>
<td>Refresh Device</td>
<td>Connects to the AccessData License Server. Downloads and overwrites the info on the CodeMeter</td>
</tr>
<tr>
<td></td>
<td>Stick or dongle with the latest information on the server.</td>
</tr>
<tr>
<td>Reload from Device</td>
<td>Begins or restarts the service to read the licenses stored on the CodeMeter Stick or dongle.</td>
</tr>
</tbody>
</table>
## Opening and Saving Dongle Packet Files

You can open or save dongle packet files using LicenseManager. When started, LicenseManager attempts to read licensing and subscription information from the dongle. If you do not have a dongle installed, LicenseManager lets you browse to open a dongle packet file. You must have already created and saved a dongle packet file to be able to browse to and open it.

### To save a security device packet file

1. Click the **Licenses** tab, then under License Packets, click **Save to File**.
2. Browse to the desired folder and accept the default name of the .PKT file; then click **Save**.

   **Note:** In general, the best place to save the .PKT files is in the AccessData LicenseManager folder. The default path is `C:\Program Files\AccessData\Common Files\AccessData LicenseManager\`.  

### To open a security device packet file

1. Select the **Licenses** tab.
2. Under License Packets, click **Open Packet File**.
3. Browse for a dongle packet file to open. Select the file and click **Open**.

## Adding and Removing Product Licenses

On a computer with an Internet connection, LicenseManager lets you add available product licenses to, or remove them from, a dongle.
To move a product license from one dongle to another dongle, first remove the product license from the first dongle. You must release that dongle, and connect the second dongle before continuing. When the second dongle is connected and recognized by Windows and LicenseManager, click on the Licenses tab to add the product license to the second dongle.

Removing a License

To remove (unassociate, or unbind) a product license

1. From the Licenses tab, mark the program license to remove. This action activates the Remove License button below the Program list box.
2. Click Remove License to connect your machine to the AccessData License Server through the internet.
3. When you are prompted to confirm the removal of the selected licenses from the device, click Yes to continue, or No to cancel.
4. Several screens appear indicating the connection and activity on the License Server, and when the license removal is complete, the following screen appears.
5. Click OK to close the message box.
   Another internet browser screen appears from LicenseManager with a message that says, “The removal of your licenses from Security Device was successful!” You may close this box at any time.

Adding a License

To add a new or released license

1. From the Licenses tab, under Browser Options, click Add Existing License. The AccessData LicenseManager Web page opens, listing the licenses currently bound to the connected security device, and below that list, you will see the licenses that currently are not bound to any security device. Mark the box in the Bind column for the product you wish to add to the connected device, then click Submit.
2. An AccessData LicenseManager Web page will open, displaying the following message, “The AccessData products that you selected has been bound to the record for Security Device nnnnnnn within the Security Device Database. “Please run LicenseManager’s “Refresh Device” feature in order to complete the process of binding these product licenses to this Security Device.” You may close this window at any time.
3. Click Yes if LicenseManager prompts, “Were you able to associate a new product with this device?”
4. Click Refresh Device in the Licenses tab of LicenseManager. Click Yes when prompted.
   You will see the newly added license in the License Options list.

Adding and Removing Product Licenses Remotely

While LicenseManager requires an Internet connection to use some features, you can add or remove licenses from a dongle packet file for a dongle that resides on a computer, such as a forensic lab computer, that does not have an Internet connection.

If you cannot connect to the Internet, the easiest way to move licenses from one dongle to another is to physically move the dongle to a computer with an Internet connection, add or remove product licenses as necessary using LicenseManager, and then physically move the dongle back to the original computer. However,
if you cannot move the dongle—due to organization policies or a need for forensic soundness—then transfer the packet files and update files remotely.

Adding a License Remotely

To remotely add (associate or bind) a product license

1. On the computer where the security device resides:
   1a. Run LicenseManager.
   1b. From the Licenses tab, click **Reload from Device** to read the dongle license information.
   1c. Click **Save to File** to save the dongle packet file to the local machine.
2. Copy the dongle packet file to a computer with an Internet connection.
3. On the computer with an Internet connection:
   3a. Remove any attached security device.
   3b. Launch LicenseManager. You will see a notification, “No security device found”.
   3c. Click OK.
   3d. An “Open” dialog box will display. Highlight the .PKT file, and click **Open**.
   3e. Click on the Licenses tab.
   3f. Click **Add Existing License**.
   3g. Complete the process to add a product license on the Website page.
   3h. Click **Yes** when the LicenseManager prompts, “Were you able to associate a new product with this dongle?”
   3i. When LicenseManager does not detect a dongle or the serial number of the dongle does not match the serial number in the dongle packet file, you are prompted to save the update file, [serial#].wibuCmRaU.
   3j. Save the update file to the local machine.
4. After the update file is downloaded, copy the update file to the computer where the dongle resides:
5. On the computer where the dongle resides:
   5a. Run the update file by double-clicking it. ([serial#].wibuCmRaU is an executable file.)
   5b. After an update file downloads and installs, click **OK**.
   5c. Run LicenseManager.
   5d. From the Licenses tab, click **Reload from Device** to verify the product license has been added to the dongle.

Removing a License Remotely

To remotely remove (unassociate, or unbind) a product license

1. On the computer where the dongle resides:
   1a. Run LicenseManager.
   1b. From the Licenses tab, click **Reload from Device** to read the dongle license information.
   1c. Click **Save to File** to save the dongle packet file to the local machine.
2. Copy the file to a computer with an Internet connection.
3. On the computer with an Internet connection:
   3a. Launch LicenseManager. You will see a notification, “No security device found”.

3b. Click **OK**.
3c. An “Open” dialog box will display. Highlight the .PKT file, and click **Open**.
3d. Click on the Licenses tab.
3e. Mark the box for the product license you want to unassociate; then click **Remove License**.
3f. When prompted to confirm the removal of the selected license from the dongle, click **Yes**.
3g. When LicenseManager does not detect a dongle or the serial number of the dongle does not match the serial number in the dongle packet file, you are prompted save the update file.
3h. Click **Yes** to save the update file to the local computer.
3i. The Step 1 of 2 dialog details how to use the dongle packet file to remove the license from a dongle on another computer.
3j. Save the update file to the local machine.

4. After the update file is downloaded, copy the update file to the computer where the dongle resides.

5. On the computer where the dongle resides:
   5a. Run the update file by double-clicking it. This runs the executable update file and copies the new information to the security device.
   5b. Run LicenseManager
   5c. On the Licenses tab, click **Reload from Device** in LicenseManager to read the security device and allow you to verify the product license is removed from the dongle.
   5d. Click **Save to File** to save the updated dongle packet file to the local machine.

6. Copy the file to a computer with an Internet connection.

**Updating Products**

You can use LicenseManager to check for product updates and download the latest product versions.

**Checking for Product Updates**

To check for product updates, on the Installed Components tab, click **Newest**. This refreshes the list to display what version you have installed, and the newest version available.

**Downloading Product Updates**

To install the newest version, mark the box next to the product to install, then click **Install Newest**.

**Note:** Some products are too large to download, and are not available. A notification displays if this is the case.

**To download a product update**

1. Ensure that LicenseManager displays the latest product information by clicking the Installed Components tab. Click **Newest** to refresh the list showing the latest releases, then compare your installed version to the latest release.
   
   If the latest release is newer than your installed version, you may be able to install the latest release from our Website.

2. Ensure that the program you want to install is not running.

3. Mark the box next to the program you want to download; then click **Install Newest**.
4. When prompted, click Yes to download the latest install version of the product.
   4a. If installing the update on a remote computer, copy the product update file to another computer.
5. Install the product update. You may need to restart your computer after the update is installed.

Purchasing Product Licenses

Use LicenseManager to link to the AccessData Web site to find information about all our products.

Purchase product licenses through your AccessData Sales Representative. Call 801-377-5410 and follow the prompt for Sales, or send an email to sales@accessdata.com.

Note: Once a product has been purchased and appears in the AccessData License Server, add the product license to a CodeMeter Stick, dongle, or security device packet file by clicking Refresh Device.

Sending a Dongle Packet File to Support

Send a security device packet file only when specifically directed to do so by AccessData support.

To create a dongle packet file
   1. Run LicenseManager
   2. Click on the Licenses tab.
   3. Click Load from Device.
   4. Click Refresh Device if you need to get the latest info from AD’s license server.
   5. Click Save to File, and note or specify the location for the saved file.
   6. Attach the dongle packet file to an e-mail and send it to: support@accessdata.com.
Virtual CodeMeter Activation Guide

Introduction

A Virtual CodeMeter (VCM) allows the user to run licensed AccessData products without a physical CodeMeter device. A VCM can be created using AccessData License Manager, but requires the user to enter a Confirmation Code during the creation process.

The latest revision of this guide can be found at:


Preparation

- Contact your AccessData sales rep to order a VCM confirmation code.
- Install CodeMeter Runtime 4.10b or newer (available on the AccessData download page).
- Install the latest release of License Manager (available on the AccessData download page).
- The following steps are to be run on the system where you want to permanently attach the VCM.

Note: Once created, the VCM cannot be moved to any other system.

- AD Lab WebUI and eDiscovery administrators, please also follow steps outlined under Additional Instructions for AD Lab WebUI and eDiscovery (page 97) in order to enable VCM licensing on the AccessData License Service.

Setup for Online Systems

To setup a Virtual CodeMeter

1. Unplug any AccessData dongles you currently have connected.
2. Launch License Manager.


3. Select Create A Local Virtual CMStick
4. Click OK.
   The Confirmation Code Required dialog appears.
5. Enter your confirmation code.
6. Click OK, AccessData License Manager will automatically synchronize with the License Server over the Internet.
7. Click OK when the update completes. License Manager will then create the VCM on your system.
8. At this point, AccessData License Manager now displays a serial number for the VCM on the Licenses tab and the VCM can now operate in a similar way to a hardware CodeMeter device.
Setting up VCM for Offline Systems

You can setup a Virtual CodeMeter on a system that is not connected to the internet (offline). You must also have one machine that connects to the internet to perform certain steps. This section details what to do on which machine.

Perform these steps on the Online system

1. Unplug any AccessData dongles you currently have connected.
2. Launch License Manager.


3. Select Create Empty Virtual CMStick (offline).
4. Click OK.
5. The resulting dialog prompts you to save the *.wibucmrau file. Enter a name and path for the file, then click Save.
6. Transfer the *.wibucmrau to the Online system.

Perform these steps on the Online system

7. Unplug any AccessData dongles you currently have connected.
8. Launch License Manager.
9. Select Create Activation File (online).
10. Click OK.
11. In the Confirmation Code Required dialog, enter your confirmation code and click OK.
12. AccessData License Manager will automatically synchronize with the License Server over the internet. Data synchronized from the server will be written to the *.wibucmrau file. Click OK when the update completes.
13. Transfer *.wibucmrau back to the offline system.

Perform these steps on the Offline system

14. Unplug any AccessData dongles you currently have connected.
15. Launch License Manager.
16. Select Create Activate Virtual CMStick (offline).
17. Click OK.
18. The resulting dialog prompts you to browse to the location of the newly updated *.wibucmrau file. Locate the file, then click Open. License Manager creates the VCM on your system.
19. At this point, AccessData License Manager should now display a serial number for the VCM on the “Licenses” tab and the VCM can now operate in a similar way to a hardware CodeMeter device.

Creating a Virtual CM-Stick with Server 2003/2008 Enterprise Editions

This section contains special instructions for using a VCM with Windows Server 2003 or 2008 Enterprise Editions. Complete each section in order.
To Create an Empty CodeMeter License Container

2. Open the CodeMeter Control Center. Make sure the window on the License tab is, empty indicating that no licenses are currently loaded.
3. Select File > Import License.
4. Browse to the License Manager program files directory.
   - 32 bit systems: C:\Program Files\AccessData\LicenseManager\  
   - 64 bit systems: C:\Program Files (x86)\ AccessData\LicenseManager\  
5. Highlight the TemplateDisc5010.wbb file, then click Import.
6. Click the Activate License button.
7. When the CmFAS Assistant opens, click Next.
8. Select Create license request, and click Next.
9. Confirm the desired directory and filename to save .WibuCmRaC. (Example: Test1.WibuCmRaC)
10. Click Commit.
11. Click Finish.

To Copy to another machine

1. Copy the new .WibuCmRaC to another machine that is not running Windows Server 2003/2008 Enterprise.

   Note: The destination system must have an active internet connection.

2. Unplug any AccessData dongles you currently have connected.
3. Launch License Manager.
4. Select Create Activation File (online).
5. Click OK.
6. In the Confirmation Code Required dialog enter your confirmation code and click OK.
7. AccessData License Manager will automatically synchronize with the License Server over the internet. Data synchronized from the server will be written to the *.wibucmrarau file. Click OK when the update completes.

To Finish the activation on the Windows Server 2003/2008 Enterprise system

3. Open the CodeMeter Control Center. Make sure the window on the License tab empty indicating that no licenses are currently loaded.
4. Select File > Import License.
5. Browse to the location where the activated .WibuCmRaC is stored. Click Import.
6. AccessData License Manager now displays a serial number for the VCM on the Licenses tab and the VCM can now operate in a similar way to a hardware CodeMeter device.

Additional Instructions for AD Lab WebUI and eDiscovery

This section provides additional information for enabling the Web User Interface to recognize a VCM.
To enable AD Lab WebUI and eDiscovery to use VCM

1. Open Registry Editor.
2. Navigate to the following key:
   
   HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products

   Add the following DWORD registry string to the key and set the value to 1:
   
   HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products | EnableACTTest

   The AccessData License Service will know to expect a VCM when EnableACTTest is set to "1."

**Virtual CodeMeter FAQs**

**Q:** How do I get a Virtual CodeMeter (VCM)?

**A:** Contact your AccessData product sales representative. They will provide you with a VCM confirmation code.

**Q:** How do VCMs work?

**A:** A VCM operates in almost exactly the same way as a hardware CodeMeter device, except that they exist as a file stored on the hard disk. During activation, the VCM file (named with a WBB extension) is tied to the hardware of the system using unique hardware identifiers. Those unique identifiers make VCMs non-portable. When AccessData License Manager is launched, it will automatically load the VCM and display its license information. From there, you can refresh, remove, add existing licenses, etc just the same you would with a hardware security device.

**Q:** Are VCMs supported on virtual machines (VM)?

**A:** No. Due to the fact that virtual machines are portable and VCMs are not, VCMs are not supported on virtual machines. Currently it is recommended to use AccessData Network License Service (NLS) to license systems running as virtual machines. CLICK HERE for more information.

**Q:** Does the AccessData Network License Service (NLS) support VCMs?

**A:** The current release of NLS does not support using VCM as a network dongle. AccessData is considering this support for a future release.

**Q:** How can I “unplug” a VCM?

**A:** If you want to prevent License Manager from automatically loading the VCM you can "unplug" it by stopping the CodeMeter Runtime Service server and then moving (cut and paste) the WBB file to a new location (renaming the file does not suffice). By default the WBB file is located at:

   - 32 bit systems: 
     C:\Program Files\CodeMeter\CmAct\ 
   - 64 bit systems: 
     C:\Program Files (x86)\CodeMeter\CmAct\

**Q:** I have activated a VCM on my system, but now I need to activate it on a different system. What should I do?
A: Since a VCM is uniquely tied to the system on which it is activated, it cannot be moved to any other system. If you need to activate a VCM on a different system, you need to contact your AccessData Sales Representative.

Q: What if I need to reinstall Windows, format my drive, change my system's hardware, or back up my VCM in case of a disaster? Will the VCM still work?

A: The VCM can be backed up by simply copying the WBB file to a safe location. It can be restored by copying the WBB file to the CmAct folder. The VCM cannot be restored without a WBB file. If you do not have a backup of your WBB file, you will need to get a new confirmation code from your AccessData Sales Representative.

Q: My AccessData product does not seem to recognize the license stored on a VCM. What am I doing wrong?

A: VCMs are supported by the following versions of AccessData products:

- FTK 1.81.6 and newer
- FTK 3.1.0 and newer
- PRTK 6.5.0 and newer
- DNA 3.5.0 and newer
- RV 1.6.0 and newer
- eDiscovery 3.1.2 and newer
- AD Lab 3.1.2 and newer
- AD Enterprise 3.1.0 and newer
- MPE+ 4.0.0.1 and newer

Ensure that the version of the product you are running support VCMs. If the version you are running is listed as supported, verify that according to License Manager, the release date of the version you are running falls before the expiration date of the license.
Network License Server (NLS) Setup Guide

Introduction

This section discusses the installation steps and configuration notes needed to successfully setup an AccessData Network License Server (NLS).

Note: Click on this link to access the latest version of this guide:

Network License Server (NLS) Setup Guide

Preparation Notes

- CodeMeter Runtime 3.30a or newer must be installed on all Client and Server systems
- AccessData License Manager must be used to prepare the network dongle. The system running License Manager must have internet access and have CodeMeter Runtime installed.
- The current release of NLS supports the following versions of Windows:
  - Windows XP 32/64 bit
  - Windows Server 2003 32/64 bit
  - Windows Vista 32/64 bit
  - Windows Server 2008 R1 32/64 bit
  - Windows 7 32/64 bit
  - Windows Server 2008 R2 64 bit

Setup Overview

To setup NLS

1. Download the latest release of NLS located in the utilities section of the AccessData download page.
2. Extract contents of ZIP to a folder of your choice.
3. On the NLS server system, run through the NLS Installation MSI and accept all defaults.
4. Prepare network dongle:
   - 4a. Provide the serial number to AD Support and request to have the "Network Dongle Flag" applied.
   - 4b. Migrate any additional licenses to the network dongle
   - 4c. Refresh the network dongle device using AccessData License Manager.
5. Launch the AccessData product on the NLS client system.
6. Enter the NLS server configuration information:
   - IP address or hostname of NLS server system
   - Port 6921
7. Click, OK.

If you encounter any problems, please read the notes below for troubleshooting information.
Network Dongle Notes

- AccessData License Manager 2.2.6 or newer should be installed in order to manage licenses on the network dongle.
- Network dongles can hold up to 120 physical licenses. Each License has a capacity to hold thousands of sub licenses (i.e. Client count or worker count).
- Contact AccessData Technical Support to have your CodeMeter device flagged as a Network Dongle (required for NLS).

NLS Server System Notes

- Make sure the CodeMeter device is flagged as Network Dongle (i.e. License Manager will show the serial as “1181234N”. To have this flag set on your CodeMeter device, please contact AccessData Technical Support).
- Server system must be configured to allow incoming and outgoing traffic on TCP port 6921.
- A web interface to view and revoke licenses all licenses is accessible at http://localhost:5555
  This page can be reached only from a web browser running locally on the NLS server system.
- A Network Dongle cannot be used to run AccessData products locally unless the NLS server is running locally.
- Some versions of Windows may not find a local NLS server when the DNS hostname of the server is provided. In those cases, it is recommended to use a static IP address.
- When using the NLS across domains, users must have permissions to access resources on both domains (either by dual-domain membership or cross-domain trust).
- When running NLS on Windows Server 2008, Terminal Services must be installed and accepting connections. If Terminal Services is not configured it will not open the port and share out the licenses correctly.
- The name of the service according to Windows is “AccessData Network License Service.”

NLS Client System Notes

- When launched, any NLS client application that needs to lease a license from the NLS server will automatically check for the following values within the Windows Registry.
  - **NetDonglePath**: The IP address or DNS hostname of the system hosting the Network License Server service which is found in the following registry key on the client system:
    - HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products\Common
  - **NetDonglePort**: The TCP port number through which the client and server systems have been configured to use. This value is located in the same key as NetDonglePath.
  - **uniqueld**: In order to lease a license from the server, the client system must first possess a unique identification value. This value is automatically generated by applications such as FTK, PRTK, or DNA. (Registry Viewer and FTK 1.x cannot be used setup initial client NLS configuration at this time.)
    - You can find the each client system's uniqueld by inspecting the following registry key:
      - HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Shared
  - The Client system must be configured to allow all incoming and outgoing traffic on TCP port 6921.
  - The following products support the ability to lease a license from a NLS server:
    - FTK 2.2.1 and newer
    - FTK 1.81.2 and newer
- FTK Pro 3.2 and newer
- PRTK 6.4.2 and newer
- DNA 3.4.2 and newer
- Registry Viewer 1.5.4 and newer
- AD Enterprise 3.0.3 and newer
- AD Lab 3.0.4 and newer
- AD Lab Lite 3.1.2 and previous
- Mobile Phone Examiner 3.0 and newer
- Explicit Image Detection (EID) Add-on
- Glyph Add-on

- Use AccessData License Manager (ver. 2.2.4 or newer) to migrate licenses off other devices and onto a network device.

- When running AccessData products on Windows Vista, 7, or Server 2008 you must choose **Run as administrator** at least once in order to lease a license from a NLS server.

- If the NLS client application is having trouble leasing a license either from the NLS server, AccessData recommends that you reset the licensing configuration to default.

- To reset the licensing configuration, delete and recreate the NLS registry key located at: 
  ```
  HKEY_LOCAL_MACHINE\SOFTWARE\AccessData\Products\Common
  ```
Chapter 9
AccessData Distributed Processing

Distributed Processing allows the installation of the Distributed Processing Engine (DPE) on additional computers in your network, allowing you to apply additional resources of up to three additional computers at a time to the processing of your cases.

Distributed Processing may not help reduce processing times unless the number of objects to be processed exceeds 1,000 times the number of cores. For example, on a system with eight cores, the additional distributed processing engine machines may not assist in the processing unless the evidence contains greater than 8,000 items.

This appendix includes the following topics

- See Distributed Processing Prerequisites on page 103.
- See Installing Distributed Processing on page 105.
- See Configuring Distributed Processing on page 107.
- See Using Distributed Processing on page 109.

Distributed Processing Prerequisites

Before installing the AccessData (AD) Distributed Processing Engine, the following prerequisites must be met (if you are not familiar with any one of these tasks, contact your IT administrator):

- The following software must be installed:
  - Evidence Processing Engine installed on the local examination machine.
  - CodeMeter Runtime software and either a USB or a Virtual CmStick. (For more information regarding the CmStick, see (page 84).)
  - Database either on the same computer, or on a second computer.
  - KFF Library.
  - McAfee Virus Scan must have an exception added for processes added to and run from the Temp Directory.
  - The Windows Temp directory must be set as default.
- A New user account that is a member of the Administrators group on the examiner machine. If you are installing on a Microsoft network with a Domain Controller, this is easily accomplished. If you are on a non-domain network or workgroup, create this same user account and password on each DPE machine, as well as on the machine holding the Case Folder and the machine holding the Evidence Folder.
  - Make a note of the user account, domain or workgroup, and the IP address of each machine.
• A familiarity with UNC paths. UNC paths are required whenever a path statement is needed during installation and configuration of the DPE, and when the path to the Case Folder, or the path to the Evidence Folder is required.
  ■ The UNC format is `\\[machine name or IP address]\[pathname]\[casefolder]`.
  ■ Computers that are all on the same network, and in the same domain or workgroup.
  ■ A familiarity with the Windows `Services.msc` to ensure appropriate Login rights for the DPE, and for restarting the service, if necessary.
  ■ A familiarity with IP addresses and how to find them on a computer.
  ■ A knowledge of the case folder path. The case folder must be shared for DPE to access it and write to it as it processes case data.

**Using PostgreSQL with Distributed Processing**

• When using PostgreSQL, please note the following:
  ■ If the computer has fewer than 16 cores (`< 16`), then in the PostgreSQL configuration file, set the `max_connections` to 60 per computer. For example, if there are 4 computers in the Distributed Processing Model in which every computer has fewer than 16 cores, then set `max_connections` to 240 (60*4).
  ■ If the computer has 16 or more cores (`>= 16`), then in the PostgreSQL configuration file, set the `max_connections` to 125 per computer. For example, if there are 4 computers in the Distributed Processing Model in which 3 computers are 8 core (`<16`) and 1 computer is 16 core (`>=16`), then set `max_connections` to 245 (60*3 + 125*1).
  ■ If there is just one computer in the Distributed Processing Model, the `max_connections` should be no less than 100.
Installing Distributed Processing

Important: Do not install the Distributed Processing Engine on the examiner machine. The install required the installation of the local Evidence Processing Engine on that machine.

Installing the Distributed Processing Engine on the examination machine disables both processing engines.

Remedy: If you have already installed both the Evidence Processing Engine and the Distributed Processing Engine on a single machine, you must:

a) stop the processes
b) uninstall from both the examination machine and the Evidence Processing Engine machines
c) restart your machine
d) install on the examination machine.
e) start the Evidence Processing Engine again

To install AccessData Distributed Processing

1. Install the Distributed Processing Engine (AccessData Distributed Processing Engine.EXE) on the computers that are to participate in case processing, (record the IP address of each one for use when configuring the DPE on the examination machine).

   The DPE install file can be found on the installation disc in the following path:
   [Drive]:\FTK\AccessData Distributed Processing Engine.EXE

   If you do not know the IP address of the machine you are installing on, do the following:
   1a. Click Start on the Windows Startbar.
   1b. Click Run.
   1c. Enter cmd.EXE in the Run text box.
   1d. If the prompt is not c:\>, type c: and press Enter.
       At the new prompt, type cd\ and press Enter.
       The resulting prompt should be c:\>.
   1e. At the c:\> prompt, type ipconfig /all.
   1f. From the resulting information, locate the Ethernet adapter Local Area Connection, and find the associated IP address. That is what you will need when you configure the Distributed Processing Engine.

   Note: AccessData recommends that you write down the IP addresses for all machines on which the DPE will be installed.

   1g. At the prompt, type exit and press Enter to close the cmd.EXE box.

   Note: The domain listed here is not necessarily the correct one to use in installation. To find the correct domain or workgroup name, right-click My Computer (On Vista or Server 2008, click Computer), click Properties > Computer Name. The Domain or Workgroup name is listed midway down the page. Please make a note of it for future use.

2. If a Security Warning appears, click Run to continue.
3. If you want to stop the install, click Cancel on the Preparing to Install screen.
4. Click Next on the Welcome screen to continue the install.
5. Read and accept the License Agreement.
6. Click **Next** to continue.

7. Accept the default destination folder (recommended), or click **Change** to specify a different destination folder.

8. Click **Next** to continue.

9. Enter the credentials to be used for running the service.
   
   * **User name**: This user account must be a member of the Administrators group on the DPE machine, and must also have access to both the case folder, and the evidence folder. If this user account is not a member of the Administrators group, or if you are not sure, check with your IT services department.

   * While it is not generally necessary on a domain, it is recommended that whether you are on a domain network, a non-domain network, or a workgroup network, you create this same user account with the same password as a member of the Administrators group on all machines involved. This acts as a fail-safe in case the domain server goes down.

   * **Domain**: The name of the domain all related computers are on. If a non-domain or workgroup network is in place, use the local DPE’s machine name or IP address in place of the domain name for this step in the installation.

   * **Password**: This user account’s password for authenticating to the domain, or to the machine on the non-domain network or workgroup. The password must be the same for this user account on each machine.

   
   The figure below illustrates the user name and password setup.
   
   The components on the top row of the figure can be all on one machine, all on separate machines, or on any combination of machines. The key is that the administrator account and password (or user account in the Administrators group—it can be any name as long as the correct permissions are assigned, and the same name/password combination is used on each machine) must exist on all the machines related to the DPE installation, including the examination and database machines, and on both the Case Folder machine and on the Evidence Folder machine. This means physically going to those machines and adding the correct user accounts manually.

10. When you have finished adding the User Credentials, click **Next** to continue.

11. Click **Install** when the Ready to Install the Program screen appears.

12. Wait while the AccessData Distributed Processing Engine files are copied into the selected path on the local machine.

13. The default path is:

   
   `[Drive]:\Program Files\AccessData\Distributed Processing Engine<Version>`.

14. Click **Finish** to complete the install and close the wizard.

**If the service fails to start**

1. Leave the **Retry/Quit** dialog open and launch the Services (services.msc) dialog from the run command.

2. Open the **Properties** dialog for the AccessData Processing Engine Service.

3. Click the **Log On** tab.

4. Verify that the logon credentials used have full Administrative rights.

5. Save the settings and exit the **Properties** dialog.

6. Stop and start the service manually.

7. Click **Retry** on the installer screen.
Configuring Distributed Processing

Once the AccessData Distributed Processing Engine is installed on the non-examination machines, configure Distributed Processing to work with the local Processing Engine.

To configure Distributed Processing to work with the local Lab Processing Engine

1. In Case Manager, click Tools > Processing Engine Config.
2. Enter the appropriate information in each field, according to the following guidelines:
   - **Computer Name/IP**: Enter the IP address of the computers where the Distributed Processing Engine is installed. The computer name can also be used if the name can be resolved.
   - **Port**: The default port is 34097. This is the port the processing host will use to communicate with the remote processing engines.
   - **Add**: Adds the computer and port to the list. You can add up to three remote processing engines (for a total of 4 engines). When the maximum number of DPE machines is reached, the Add button will become inactive.
   - **Remove**: Removes a processing engine from the list of available engines. The localhost engine cannot be removed.
   - **Enable**: Enables the engine for use by the processing host. Until implemented, each engine you add will be set to enabled (Disabled = False) by default. When implemented, you will be able to change the selected computer’s status from Disabled to Enabled.
   - **Disable**: Makes the engine unavailable for use in processing. When implemented, you will be able to change the selected computer’s status from Enabled to Disabled. The disabled remote engine will remain on the list, but will not be used.
   - **Disabled = True**: Displays for that engine in the DPE list.
   - **Maintain UI performance while processing**: Allows you to decide whether processing speed or UI performance is more important.

   **Note:** This will slow processing, and when selected, applies to all Remote DPEs.

3. When all DPE machines have been added to the Processing Engine Configuration dialog, click Close.

If you have not yet configured the Distributed Processing Engine on the remote computers, or if you have, but it is not working properly, you will see the warning shown in the following figure.

To correct this

1. On the remote computer having the Distributed Processing Engine installed, click Start.
   1a. Right-click My Computer.
   1b. Click Manage.
   1c. Under System Tools, click Local Users and Groups.
   1d. Click Groups.
   1e. Double-click Administrators.
   1f. Verify that the user account name that was used in installation is in this group.
   1g. Click OK to close this dialog.
2. Under Local Users and Groups, click Users.
   2a. Find the user account name in the list, and double-click it.
   2b. Mark the box User cannot change password.
   2c. Mark the box Password never expires.
2d. Click **Apply**.
2e. Click **OK**.

3. Do one of the following:
   - Under Services and Applications, click **Services**.
   - If you already closed the Computer Management dialog, launch the Services (services.msc) dialog from the Run command on the Start menu.

3a. Open the Properties dialog for the AccessData Processing Engine Service.
3b. In the General tab, find Startup Type. If it says Automatic, proceed to the next step. If it says anything else, click the drop-down on the right side of the text box and select Automatic from the list. Click **Apply** and proceed to the next step.
3c. Open the **Log On** tab.
3d. Verify that the **Log On information** is set to the user name, domain or DPE machine name, and password that matches the user account you just verified (should be the one that was entered during installation).
3e. Click **OK**.

4. Right-click on the **AccessData Processing Engine Service**.
5. Click **Stop** to stop the service.
6. Click **Start** to re-start the service manually.
7. Click **Retry** on the installer screen.
8. Ensure that the user name provided during installation is a member of the Administrators account.
Using Distributed Processing

To utilize the Distributed Processing Engine when adding evidence to a case

1. Make sure the case folder is shared before trying to add and process evidence.
2. Enter the path to the case folder in the Create New Case dialog in UNC format.
3. Click Detailed Options, and select options as you normally would.
4. Click OK to return to the New Case Options dialog.
5. Mark Open the case and then click OK to create the new case and open it.
6. The new case is opened and the Manage Evidence dialog is automatically opened. Click Add. Select the evidence type to add. Select the evidence file to add and then click Open.
7. The path to the evidence is designated by drive letter by default. Change the path to UNC format by changing the drive letter to the machine name or IP address where the evidence file is located, according to the following syntax:
   \[computername_or_IP_address\][pathname][filename]
8. Leave the remaining path as is.
9. Click OK.

Note: If a case was originally processed using distributed processing, when a reviewer conducts a live search, the system will first attempt to use the computer with the distributed processing engine, but if it is not available, it will use the reviewer’s local computer to conduct the search.

Checking the Installation

When you have completed the installation, open the Task Manager on the remote computer, and keep it open while you add the evidence and begin processing. This will allow you to watch the activity of the ProcessingEngine.EXE in the Processes tab.

The Distributed Processing Engine does not activate until a case exceeds approximately 30,000 items. When it does activate, you will see the CPU percentage and Memory usage increase for the ProcessingEngine.EXE in Task Manager.